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PowerQuest® Server License Agreement

IMPORTANT: Read this before using your copy of PowerQuest software.

This document is a legal agreement between you (an individual or business) and PowerQuest Corporation (PowerQuest). Use of the 
software indicates your acceptance of these terms. As used in this License Agreement, the term “Software” means the software 
included on the CD or disk media provided with this License Agreement. The term “Software” does not include any software that is 
covered by a separate license offered or granted by a person other than PowerQuest.

IF YOU DO NOT AGREE TO THESE TERMS AND CONDITIONS, EITHER DESTROY OR RETURN, INTACT, THE 
SOFTWARE PACKAGE, CONTAINING THE CD OR DISK MEDIA, TOGETHER WITH THE OTHER COMPONENTS OF 
THE PRODUCT TO THE PLACE OF PURCHASE FOR A REFUND OF THE PURCHASE PRICE.

1. PROPRIETARY RIGHTS. The Software and any accompanying documentation are the proprietary products of PowerQuest or 
its licensors and are protected under national laws and international treaty provisions. Ownership of the Software and all copies, 
modifications, translations, and merged portions thereof shall at all times remain with PowerQuest or its licensors.

2. GRANT OF LICENSE. The Software and accompanying documentation are being licensed to you, which means you have the 
right to use the Software only in accordance with this License Agreement. The Software is considered in use on a computer when it 
is loaded into temporary memory or installed into permanent memory. This License may not be assigned or otherwise transferred 
without prior written consent from PowerQuest, and any unauthorized transfer is null and void.

PERSONAL LICENSE. This license is personal to you. You may not sublicense, lease, sell, or otherwise transfer the Software or 
any of the accompanying documentation to any other person. You may use the Software only for your own personal use if you are 
an individual, or for your own internal business purposes if you are a business. If you are a service bureau, integrator, value added 
reseller, or other type of service provider and wish to use this software on your clients’ computers, you must purchase a 
Configuration License.

SERVER-SPECIFIC LICENSE. Each permitted copy of the Software may be used only in connection with one network server 
owned or leased by you. Once a copy of the Software has been used on a server, it may not be used on any other server. If the 
Software is made available on a network, it may be accessed only by ONE specific computer. Once the Software has been accessed 
by ONE specific computer it may not be used on any additional computers without purchasing additional licenses.

NUMBER OF COPIES LICENSED. You are authorized to use ONLY a single copy of the Software on the number of servers for 
which you have purchased a license as indicated on the accompanying license certificate. All copies of the Software must include 
the copyright, trademark, and patent notices.

BACKUP COPY. In addition to any copies authorized under this license agreement, you may make a single copy of the Software 
solely for backup purposes.

UPDATES, UPGRADES AND SUPPORT. You are entitled to receive technical support as outlined in the Software 
documentation. You are entitled to receive Software updates in accordance with PowerQuest policies as announced from time to 
time on terms comparable to those offered to other users of the Software under the server licenses.

TERM. This license is effective from your date of purchase and shall remain in force until terminated. You may terminate the 
license and this License Agreement at any time by destroying the Software and the accompanying documentation, together with all 
copies in any form.

3. NONPERMITTED USES. Without the express prior written permission of PowerQuest, you may not (a) use, copy, modify, 
alter or transfer, electronically or otherwise, the Software or documentation except as expressly permitted in this License 
Agreement, or (b) translate, reverse program, disassemble, decompile, or otherwise reverse engineer the Software.

4. EXPORT CONTROLS. Certain uses of the Software by you may be subject to restrictions under U.S. regulations relating to 
exports and ultimate end uses of computer software. You agree to fully comply with all applicable U.S. laws and regulations, 
including but not limited to the Export Administration Act of 1979 as amended from time to time and any regulations promulgated 
thereunder.

5. U.S. GOVERNMENT RESTRICTED RIGHTS. If you are acquiring the Software on behalf of any unit or agency of the 
United States Government, the following provision applies:  It is acknowledged that the Software and the documentation were 
developed at private expense and that no part is in the public domain and that the Software and documentation are provided with 
RESTRICTED RIGHTS. Use, duplication, or disclosure by the Government is subject to restrictions as set forth in subparagraph 
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(c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) 
of the Commercial Computer Software-Restricted Rights at 48 CFR 52.227-19, as applicable. Contractor/Manufacturer is 
PowerQuest Corporation/P.O. Box 1911/Orem, UT 84059-1911/U.S.A.

6. LIMITED WARRANTY. (a) PowerQuest warrants to you, the original end user, (i) that the Software, other than third-party 
software, will perform substantially in accordance with the accompanying documentation and (ii) that the Software is properly 
recorded on the disk media. This Limited Warranty extends for ninety (90) days from the date of purchase. PowerQuest does not 
warrant any third-party software that is provided with the Software, but PowerQuest agrees to pass on to you any warranties of the 
owner or licensor to the extent permitted by the owner or licensor. (b) This Limited Warranty does not apply to any Software that 
has been altered, damaged, abused, mis-applied, or used other than in accordance with this license and any instructions included on 
the Software and the accompanying documentation. (c) PowerQuest's entire liability and your exclusive remedy under this Limited 
Warranty shall be the repair or replacement of any Software that fails to conform to this Limited Warranty or, at PowerQuest's 
option, return of the price paid for the Software. PowerQuest shall have no liability under this Limited Warranty unless the 
Software is returned to PowerQuest or its authorized representative, with a copy of your receipt, within the warranty period. Any 
replacement Software will be warranted for the remainder of the original warranty period or 30 days, whichever is longer. (d) THIS 
WARRANTY IS IN LIEU OF AND EXCLUDES ALL OTHER WARRANTIES NOT EXPRESSLY SET FORTH HEREIN, 
WHETHER EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY WARRANTIES OF MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE, NON-INFRINGEMENT, OR WARRANTIES ARISING FROM USAGE OF 
TRADE OR COURSE OF DEALING. (e) THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS; YOU MAY HAVE 
OTHERS WHICH VARY FROM STATE TO STATE. (f) Your failure to return the enclosed registration card or complete the 
electronic registration included with the Software may result in PowerQuest's inability to provide you with updates to the Software, 
and you assume the entire risk of performance and result in such an event.

7. LIMITATION OF LIABILITY. IN NO EVENT SHALL POWERQUEST'S LIABILITY RELATED TO ANY OF THE 
SOFTWARE EXCEED THE LICENSE FEES ACTUALLY PAID BY YOU FOR THE SOFTWARE. EXCEPT FOR A RETURN 
OF THE PURCHASE PRICE UNDER THE CIRCUMSTANCES PROVIDED UNDER THE LIMITED WARRANTY, 
NEITHER POWERQUEST NOR ITS SUPPLIERS SHALL IN ANY EVENT BE LIABLE FOR ANY DAMAGES 
WHATSOEVER ARISING OUT OF OR RELATED TO THE USE OF OR INABILITY TO USE THE SOFTWARE, 
INCLUDING BUT NOT LIMITED TO DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES, 
AND DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, 
OR OTHER PECUNIARY LOSS, EVEN IF POWERQUEST CORPORATION HAS BEEN ADVISED OF THE POSSIBILITY 
OF SUCH DAMAGES, WHETHER SUCH LIABILITY IS BASED ON CONTRACT, TORT, WARRANTY, OR ANY OTHER 
LEGAL OR EQUITABLE GROUNDS. BECAUSE SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION 
OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY NOT APPLY TO 
YOU.

8. NO WAIVER. Any failure by either party to this agreement to enforce a specific part of the agreement in a specific situation is 
not a waiver of rights under the agreement. The party may still enforce the rest of the agreement in that situation and may still 
enforce some or all of the agreement in other situations.

9. This License Agreement constitutes the entire agreement between you and PowerQuest pertaining to its subject matter. This 
License Agreement is governed by the laws of the State of Utah. Any litigation arising from this license will be pursued only in the 
state or federal courts located in the State of Utah. Even if part of the agreement is held invalid, the rest of the agreement is still 
valid, binding and enforceable.

Should you have any questions concerning this Agreement, or if you desire to contact PowerQuest Corporation for any reason, 
please write: PowerQuest Corporation/P.O. Box 1911/Orem, UT 84059-1911/U.S.A.

© 1994-2001 PowerQuest Corporation. All rights reserved. The Software is protected by U.S. patents, with other patents pending in 
the U.S.A. and elsewhere. PowerQuest is a registered trademark of PowerQuest Corporation.
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Introduction

What Is PowerQuest VolumeManager?

With PowerQuest® VolumeManager™, you can quickly and easily create and manage 
partitions and manage existing volume sets for storing valuable information such as data 
files, applications, and operating systems. Storing information in separate volume sets and 
partitions helps you organize and protect your data and reclaim wasted disk space.

VolumeManager enables you to secure your data by physically separating it from other 
files. Separate volume sets and partitions also make backups easy.

PowerQuest VolumeManager includes PowerQuest ControlCenter ST for StorageMonitor, 
a web-based console that enables you to gather critical information about your managed 
servers.

About This Guide

This user guide can help you set up and use PowerQuest® VolumeManager™.

The VolumeManager CD includes a searchable PDF version of this manual in the 
English/Docs folder. The filename is VM2.PDF. PowerQuest recommends that you have 
Adobe® Acrobat® version 4.0 or later for best viewing quality. You can download the 
current version of Acrobat for free from the Adobe web site, www.adobe.com. In the PDF 
version of this manual, you can click cross-references (including page numbers in the 
table of contents and index) to jump to the relevant material. You can also click references 
to web sites to start your browser and go to the web site. The hand pointer in Acrobat 
changes to a pointing finger when it is located over text that is linked to other material.

The user guide consists of the following sections:

• The Introduction provides an overview of PowerQuest VolumeManager.

• Part 1: Installation and Configuration explains the installation and configuration of 
VolumeManager and ControlCenter ST for StorageMonitor and includes information 
for system administrators. See Chapter 1.

• Part 2: ControlCenter ST for StorageMonitor explains the components of 
ControlCenter ST for StorageMonitor and provides step-by-step instructions for using 
it to monitor managed servers. See Chapters 2 – 5.

http://www.adobe.com
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• Part 3: PowerQuest VolumeManager explains the components of VolumeManager 
and provides step-by-step instructions for using VolumeManager. See Chapters 
6 – 13.

• Part 4: Appendices includes helpful information about using VolumeManager with 
other programs, lists answers to problems, and provides technical support options. 
See Appendix A – Appendix C.

• The Index helps you locate topics discussed in the user guide.

In addition to this manual, VolumeManager ships with a VMSCRIPT.PDF file that 
explains VolumeManager scripting and command line switches. You can find the PDF file 
in the English/Docs folder on the VolumeManager CD.
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C H A P T E R1
Getting Started
This chapter includes the following information:

• VolumeManager System Requirements

• StorageMonitor System Requirements

• Installation Overview

• Installing VolumeManager

• Installing StorageMonitor

• Creating VolumeManager Rescue Disks

• Uninstalling VolumeManager

• Getting Help
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VolumeManager System Requirements

To run VolumeManager, your server must be equipped to run Windows 2000 or Windows 
NT 4.0 and must meet the following requirements:

* More memory may be required to manipulate FAT32 and NTFS partitions on hard disks 
larger than 4 GB.

You may use a web server and an SMTP mailing address for e-mail reporting.

From Windows Rescue disks

Processor Intel 486 DX/33 or above for 
Windows NT Server; 
Pentium/133 or above for 
Windows 2000

Intel 286 DX/33 MHz or above

RAM 64 MB for Windows NT 4.0; 
128 MB for Windows 2000 
Server and Windows 2000 
Advanced Server

32 MB*

Hard-disk 
space

65 MB Installed to floppy disks

Operating 
System

Windows NT 4.0 Server with 
SP4 applied; Windows 2000 
Server; or Windows 2000 
Advanced Server

MS-DOS 6.2 or compatible DOS 
(Caldera DOS is included on the 
rescue disks.)

3.5-inch 
diskette drive

High-density High-density

CD-ROM 
drive

Any speed None

Monitor VGA-compatible VGA-compatible
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StorageMonitor System Requirements

In addition to the system requirements for Windows 2000 or Windows NT 4.0 and 
VolumeManager, you will need the following to run PowerQuest ControlCenter ST for 
StorageMonitor:

The ControlCenter ST for StorageMonitor components may be installed in three different 
configurations, depending on the equipment you have available.

• Install all components on a single machine

• Install the control server and IIS web server on one machine and the database server 
on another machine

• Install the control server on one machine, the IIS web server on a second machine, 
and the database on a third machine

Component Hardware Software

StorageMonitor 
control server

• 366 MHz Pentium II 
processor or higher

• 128 MB of RAM
• 25 MB hard disk free 

space

• Windows 2000 Server and 
Advanced Server or Windows 
NT 4.0 Server

• WinSock2
• Microsoft Internet 

Information Services
• TCP/IP
• Microsoft Internet Explorer 

5.0 or higher

Web server (IIS 
server)

• IIS version 4.0 or higher

MSDE (Microsoft 
Data Engine) 
database

• (Optional) Microsoft SQL 
Server 7.0

ControlCenter ST 
Agent (installed 
on the managed 
servers)

• 366 MHz
• 32 MB of RAM
• 5 MB hard disk free 

space

• Windows 2000 Server and 
Advanced Server or Windows 
NT 4.0 Server 
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Installation Overview

The VolumeManager CD includes an installation program for VolumeManager and for 
ControlCenter ST for StorageMonitor.

1 Register your software with PowerQuest.

If your software is not registered, you will not be able to get the license file required 
to run VolumeManager. ControlCenter ST for StorageMonitor does not require a 
license file to run, but VolumeManager does.

2 Insert the VolumeManager CD into your CD-ROM drive.

3 If the installation program does not start automatically, click Start ➤ Run on the 
Windows taskbar. Type drive: \AUTORUN, where drive is the drive letter of 
your CD-ROM drive.
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4 Click the installation option you want, and follow the on-screen installation 
instructions.

Installing VolumeManager

To install and run VolumeManager, your user account must be a member of the 
Administrator and/or Domain Admins groups. If you have trouble installing or running 
VolumeManager because of user permissions, you should check to see which groups your 
user account is a member of. If the user account is a member of other, more restrictive 
groups, VolumeManager will not install or run. To solve the problem, either create a new 
account that is only a member of the Administrator or Domain Admins groups, or remove 
your account from more restrictive groups.

IMPORTANT! VolumeManager must be installed on a local drive, not on a network drive.

1 Choose the installation option you want from the second browser screen.

If your software is not registered, you will not be able to get the authorization code 
required to run VolumeManager.

Click this: To do this:

VolumeManager Install a Windows application for managing the hard disks 
on your server. See “Installing VolumeManager” on page 
9.

ControlCenter ST Install the components necessary to run a web-based 
console for monitoring your managed servers. See 
“Installing StorageMonitor” on page 14.

Technical Support Create a set of VolumeManager rescue disks or display a 
link to the PowerQuest technical support web site.

Select Language Select the language of the product you want to install. 
English, German, French, and Japanese software are 
included on the CD.

Exit Exit the installation program.

Click this: To do this:

Install Install VolumeManager.
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Node Locking

Node locking is a feature that verifies whether VolumeManager is run with a valid license. 
At the end of installation, VolumeManager checks for the presence of a license file. If it is 
not found, it prompts you to get a valid license from the PowerQuest web site. 

Part of the node locking process is dependent on the GLOBEtrotter web site, which is 
available in English only.

IMPORTANT! If you have not registered your software, you must do so before 
proceeding. If you ordered the product directly from PowerQuest, the 
serial number is already registered. If you purchased the product through a 
third-party vendor, you can register the serial number by visiting the 
PowerQuest web site at www.powerquest.com/register or by calling 
Priority Technical Support at 1-888-438-1260 (in the U.S.), 00 8 00 2882 
8828 (in Germany, France, or the United Kingdom), or +31 (0)20 581 
3907 (in other European countries). If you do not register your software, 
you will not be able to complete the license fulfillment steps. 

The FLEXlm License Finder dialog contains the following three options:

• Specify the License Server. VolumeManager does not count concurrent license uses; 
thus, there is no license server. Do not click this option.

Documentation Link to the VolumeManager user guide and scripting user 
guide.

Back Return to previous browser screen.

Click this: To do this:
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• Specify the License File. Use this option if you have installed a license file to disk. 
See “Specifying the License File” below.

• Fulfill license from the Internet. Use this option when you have purchased one or 
more licenses from PowerQuest (you have a registered product serial number), and 
you are installing the product on a machine. If the product is already installed, select 
this option the first time you run the software. See “Fulfilling the License from the 
Internet” below.

Specifying the License File

The Specify the License File option lets you specify the location of the license file.

1 Choose Specify the License File.

2 Type the location of the license file, then click Next.

3 Click Finish.

Fulfilling the License from the Internet

The Fulfill License from the Internet option lets you obtain a license for the software 
from the Internet. Be aware that you must register your software with PowerQuest before 
you can obtain a license file for the software.

IMPORTANT! If you do not have Internet access, refer to the READMEVM.TXT file on 
the VolumeManager CD for instructions on getting a license file.

1 Choose Fulfill license from the Internet.

The License Fulfillment Wizard appears and reminds you to connect to the Internet. 
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2 Click Next. 

The Server URL web address should be filled in automatically.

3 In the Key field, enter your serial number then click Next.

The serial number can be found (depending on how you purchased the product) on the 
bottom of the disk sleeve, on the order approval page, or on the certificate of 
purchase.

This dialog lists any products for which you bought licenses from PowerQuest.
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4 Select the product you want, then click Next. 

5 In the Host ID field, select one of the unique computer identifiers listed in the 
drop-down box.

The preferred ID is the MAC address (an identifier from your network interface card); 
however, other IDs are available in the drop-down list.

If you have a removable network card and often use the computer without the card, 
you may want to choose your C: drive serial number instead of the MAC address to 
identify your machine.

If your Internet address is generated by a DHCP server, you should not use the 
INTERNET Host ID because it will change each time you log in.

6 Enter the name of the machine, then click Next

The wizard is now ready to connect to the server to fulfill your license. 
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7 Verify the information, then click Next. 

8 Click Install License on this computer to install the license, or click Save License 
to Disk if you want to install it manually at a later time. Click Next.

When the license installer has finished, the bottom of the dialog displays the location 
where the license file was saved.

9 Click Finish twice.

PowerQuest products use GLOBEtrotter’s FLEXlm (flexible license manager) to 
node lock applications. The GLOBEtrotter’s FLEXlm End Users Guide, an HTML 
document, describes how you can set up and manage license files. You can access this 
file from GLOBEtrotter’s web site, www.globetrotter.com. You should be aware, as 
you read through the manual, that VolumeManager uses uncounted, node-locked 
licenses.

Before you run VolumeManager, review “Before Running VolumeManager” on page 50.

Installing StorageMonitor

PowerQuest ControlCenter ST for StorageMonitor is a feature of VolumeManager that 
allows you to view system, volume, and partition information for managed servers from a 
web-based console. 

Before you install StorageMonitor, you must apply the most recent Windows 
NT/Windows 2000 service pack. Then, follow these instructions to install StorageMonitor.

1 Insert the VolumeManager CD into your CD-ROM drive.

2 If the installation program does not start automatically, click Start ➤ ➤ ➤ ➤ Run on the 
Windows taskbar.



PowerQuest VolumeManager 15

3 Type drive: \AUTORUN, where drive is the drive letter of your CD-ROM drive.

4 Click Setup.exe, and follow the on-screen installation instructions.

When you install StorageMonitor, the following components are configured:

After you have successfully installed the console, you can install the ControlCenter ST 
Agent.

Installing the ControlCenter ST Agent

The ControlCenter ST control server software (and its components) and StorageMonitor 
should be installed first. After the server is configured, you can set up the agents on the 
network to enable communication with the control server. You must install the agent on 
every server you want to monitor with ControlCenter ST.

Servers where the agent is running are called managed servers.

1 Insert the VolumeManager CD into the CD-ROM drive of the server you want to 
monitor using ControlCenter ST.

2 If the installation program does not start automatically, click Start ➤ ➤ ➤ ➤ Run on the 
Windows taskbar. Type drive: \AUTORUN, where drive is the drive letter of 
your CD-ROM drive.

3 Click ControlCenter ST, and follow the on-screen instructions.

4 Click Install Agent.

Component Function

Web console Displays all managed servers.

Control server Installs a Windows NT service that allows communication 
between the web-based console and the ControlCenter ST Agent.

DHCP server Configures an existing Windows NT or Windows 2000 DHCP 
service that gives the control server’s IP address to client agents 
so that they can communicate.

Agent Installed on each managed server in an enterprise so the control 
server can see each system on the web console interface.
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When the control server and agents are correctly installed, an IT professional or system 
administrator will be able to run the console remotely from a web browser anywhere in the 
world.

Configuring the IIS Server

Before you run ControlCenter ST for StorageMonitor, you must configure your IIS server 
so that it will locate the virtual directories for the CGI programs and HTML files. The 
installation will give you a prompt to choose a directory for the web components. You 
should browse to a place in the file system and create a directory for the HTML files and 
the CGI scripts.

Following installation, you must configure a web site using Microsoft Internet Services 
Manager to display the console HTML pages.

1 Create a new web site for ControlCenter ST.

2 Set the “Home Directory” of the web site to the path that you specified as the web site 
home directory during the install.

3 Edit the Properties of the PQCGI folder under the web site. Set the execute 
permissions of this directory to run “Scripts and Executables.” For security, you 
should revoke the “Read” permissions for this directory.

4 Edit the Properties of the PQHTML folder under the web site. Set the execute 
permissions of this directory to “None.” Give this directory “Read” permissions. For 
security, you should probably revoke all other permissions.

5 Edit the Properties of the web site.

6 Click on the Documents tab. Remove all items listed in “Default Documents.”

7 Add “PQCGI/PQCCST/login.exe” to the “Default Documents.”

After you have successfully installed StorageMonitor, you can log on and begin using 
ControlCenter ST for StorageMonitor. See “Logging On” on page 22.

Creating VolumeManager Rescue Disks

You can create rescue disks to run VolumeManager if your operating system fails or your 
computer becomes unbootable. See “Running VolumeManager from Rescue Disks” on 
page 55 for information about how the rescue disks vary from the Windows NT 
executable.



PowerQuest VolumeManager 17

You must have two blank 1.44 MB floppy disks available before you begin this procedure 
(three disks for Asian, double-byte languages).

1 You can create rescue disks three ways:

2 Insert a blank formatted 1.44 disk into your 3.5-inch disk drive and click OK.

3 Follow the prompts and the instructions on the progress bar (located at the bottom of 
the window).

The rescue disks contain the following files:

If you create rescue disks for a double-byte (Asian) language, the third disk includes fonts.

To create rescue 
disks from: Do this:

VolumeManager 
CD

From the CD browser, click Technical Support ➤ ➤ ➤ ➤ Create 
VolumeManager Rescue Disks.

From a command prompt (or from DOS), you can change 
the current folder to \English\DOS-OS2 located on the 
VolumeManager CD. Insert a blank, formatted floppy 
diskette in the drive, then type MAKEDISK A: where A: 
is the letter for the drive.

VolumeManager 
main window

Click Tools ➤ Create Rescue Disks on the menu bar.

Windows Click Start ➤ Programs ➤ PowerQuest VolumeManager 
2.0 ➤ Create Rescue Disks.

VolumeManager 2.0 Disk 1 VolumeManager 2.0 Disk 2

• Partinfo.exe (utility program)
• PTEDIT (utility program)
• Keyb.com
• Mode.com
• Miscellaneous system files

• Mouse.com
• VMHelp.dat (help file)
• VMdos.exe
• VMdos.ovl
• VMdos.pqg
• PQPB.rtc
• Rescue.txt
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If you run out of space on the first rescue disk as a result of adding network, SCSI, or 
CD-ROM drivers to your boot sequence, you can delete the following files from the disk: 
chkdsk.com, fdisk.exe, ptedit.exe, and partinfo.exe. We recommend that you delete the 
files in that order, freeing up only the space that you need to accommodate additional files. 
These files are included in the Utilities folder on the VolumeManager CD where you can 
access them later, if necessary.

If you use an international keyboard or character set, you will need to modify the 
AUTOEXE2.BAT and CONFIG.SYS files on the rescue disks. See “Using International 
Keyboards” on page 68 for additional information.

Uninstalling VolumeManager

1 On the Windows taskbar, click Start ➤ Settings ➤ Control Panel.

2 Double-click Add/Remove Programs.

3 Select VolumeManager 2.0.

4 Click Add/Remove.

5 Select Remove, then click Next.

Getting Help

PowerQuest VolumeManager provides in-depth information on features as well as 
step-by-step instructions for specific tasks.

To access online Help, click Help ➤ ➤ ➤ ➤ Contents on the menu bar in the VolumeManager 
main window.

By clicking Help in the lower right corner of the dialog, you can open context-sensitive 
help for the dialog. 

The READMEVM.TXT and README.TXT files include information that changed since 
this guide was written, corrections to the manual or help system, and information specific 
to installation or configuration issues.

There is no online help for ControlCenter ST for StorageMonitor.
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Overview
A good web-based PC server management system includes the ability to automate the 
gathering of network server information and display the results in an organized, 
easy-to-read manner. PowerQuest® ControlCenter ST™ for StorageMonitor fills that need 
with comprehensive reporting on the servers and volumes on a LAN/WAN using a 
web-based console as the viewer.

When used in conjunction with PowerQuest VolumeManager, StorageMonitor is the 
perfect reporting tool for all your managed enterprise servers.

StorageMonitor Components

StorageMonitor includes the following components:

Component Function

StorageMonitor 
web-based console

• Identifies and displays all online and offline servers you 
are managing on a LAN/WAN.

• Displays detailed system, volume, and partition 
information pertaining to each server to simplify volume 
and partition manipulation through PowerQuest 
VolumeManager.

• Alerts the administrator (via e-mail, pager, or cellular 
telephone) to managed server performance issues.

• Displays the ping history of a selected server.

• Reads and stores system and volume information data of a 
managed server in an ODBC-compliant database.

Control server • An NT service that communicates with the 
ControlConsole ST Agent on each managed server to get 
system and volume information.

• Receives notification of managed server startup and 
shutdown and stores the current state of the server in the 
ODBC database.

• Pings each managed server at specified intervals to check 
whether the server is up and running.
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Using the Console

You can use ControlCenter ST for StorageMonitor with VolumeManager as a reporting 
tool that can manage servers anywhere in the world. You do not need to install 
VolumeManager on each managed server. Installing the ControlCenter ST Agent on each 
managed server allows you to manage those servers.

The following are basic functions of the console that will help you to get started and set 
up.

• Logging On
• Setting Options
• Logging Off

Logging On

1 Start ControlCenter ST.

Web server (IIS 
server)

• A Microsoft Internet Information Server for Windows 
2000 Professional that provides a method for the 
applications in the web console to access the ODBC 
database.

MSDE (Microsoft 
Data Engine) 
database

• Stores server system and volume information that the 
control server receives from each managed server.

• The control server and the web console access it for stored 
information.

• Can be installed on the same machine as the control server.

ControlCenter ST 
Agent

• Installed on every managed server in an enterprise so the 
console server can see each system on the web console 
interface, through DHCP or static IP protocol.

• The managed servers send system and volume information 
to the control server for storage in the ODBC database, so 
the control server administrator can reference and query 
the information.

• Provides managed server communication with the control 
server and receives action requests from the control server.

Component Function
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2 Type your user name and password.

Passwords are case-sensitive.

3 Select the language for the software from the drop-down list.

4 If you have installed both StorageMonitor and DeployCenter, click StorageMonitor.

If you encounter “Error. Please try later” when logging into ControlCenter ST for 
StorageMonitor, you should change your proxy server settings in Internet Explorer. In 
Internet Explorer, click Tools ➤ Internet Options ➤ Connections tab ➤ LAN Settings. 
Then under Automatic configuration, select Automatically detect settings, or under 
Proxy server, select Bypass proxy server for local addresses.

Setting Options

1 At the top of the screen, click Options.

2 Select any configuration options you want (such as setting the default threshold levels 
or the ping frequency) so that your machine is configured for your specific needs. 

See “Configuring the Console” on page 35 for more information about setting 
options.



3 Click Save.

You must wait for the mail buffer to clear before any global default settings you choose are 
updated. Until the mail buffer clears, it may appear as though your settings have not 
changed.

Logging Off

1 Click Log Off in the upper right corner of the screen.

You will exit the console and return to the Log In screen.
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C H A P T E R2
Identifying Servers
This chapter includes the following information:

• Overview

• Creating a User-Defined Server Group

• Deleting or Renaming a User-Defined Server Group

• Modifying User-Defined Groups

• Deleting a Server from a User-Defined Group
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Overview

A server must have the ControlCenter ST Agent installed before it is controllable from the 
console. When the agent is installed, the console can monitor the system information, 
volume information, partition information, and alert settings of each server. For 
information on installing ControlCenter ST for StorageMonitor and the ControlCenter ST 
Agent, see Chapter 1 of this user guide.

You can create new server groups to be monitored by the console or choose to use 
Directory Services predefined groups. Each group will have the system and volume 
information for each server in the group. Organizing servers into groups makes monitoring 
easier and also makes quick access to an individual server easier.

Creating a User-Defined Server Group

If the automatic server groupings do not meet your needs, you can create a user-defined 
group that includes any of the servers you choose. You can create a main group or a 
subgroup.

Creating a Main Group

1 Click Servers ➤ User-Defined Groups in the left pane.

The Add New Group dialog is displayed.

2 Type a group name in the Group Name text box.

3 Click Save.

Creating a Subgroup

4 Locate the position in the Servers tree where you want to create a new subgroup, and 
click on the main group’s name.

The User-Defined Group screen is displayed.

5 Click New Group in the right pane.

The Add New Group dialog is displayed.

6 Type a group name in the Group Name text box.

7 Click Save.
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Deleting or Renaming a User-Defined Server Group

1 In the left pane, click Servers.

2 Under User-Defined Groups, navigate to the group that you want to delete.

3 Click Delete/Rename Group.

4 On the Delete/Rename screen, click Delete or Rename.

Modifying User-Defined Groups

1 In the left pane, click Servers.

2 Under User Defined Groups, navigate to the group you want to modify.

3 In the right pane, click Modify Group.

The servers in the group will display under Selected Computers.

You can add servers to the group by performing a search and adding servers from a 
list of machines that match the criteria you choose.

Search options display in the left pane. You can search all the managed servers by 
computer name, or operating system.

4 Select the search criteria you want to use, enter the value you want, then click Go.
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For example, if you want to search for Windows NT servers, you could choose OS, 
then type Windows NT.

The servers that match the criteria you specified display under Search Results in the 
right pane.

5 Select the computers you want from the list by clicking them, or click Select All to 
choose all the computers that matched your search criteria.

6 Click Add.

The computers you add will display under Selected Computers in the bottom of the 
right pane.

7 Click Finish to save the modified group.

Deleting a Server from a User-Defined Group

1 In the left pane, click Servers.

2 Under User-Defined Groups, navigate to the group in which the server you want to 
delete is found.

3 In the right pane, click Modify Group.

4 In the right pane under Selected Computers, select the server you want to delete 
from the group.

5 Click Remove.
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C H A P T E R3
Reporting
This chapter includes the following information:

• Viewing All Servers

• Viewing Servers within a Group

• Viewing Server Information

• Viewing All Volume Sets
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Viewing All Servers

You can view information about all of the managed servers that are connected to the 
StorageMonitor web console. This report is useful if you just want a quick, broad 
overview of the status of each managed server.

Be sure you have first installed and correctly configured a ControlCenter ST Agent on one 
or more servers whose information you want to review. See “Editing the ControlCenter ST 
Agent Settings” on page 41 for more information.

1 In the left pane, click Servers ➤ ➤ ➤ ➤ All Servers.

2 Click the Servers View tab in the right pane.

Viewing Servers within a Group

You can view servers within their pre-defined and user-defined groups. This report is 
useful for identifying servers within a particular group and displaying general information 
about a managed server.

1 In the left pane, click Servers ➤➤➤➤ Directory Groups or User Defined Groups.

See “Creating a User-Defined Server Group” on page 26 to create your own groups.

2 Click a group name.
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A table is displayed that lists all known servers within the directory group you selected. 

Viewing Server Information

You can view detailed system, volume, partition, and alert setting information about a 
specific managed server.

1 In the left pane, click Servers ➤➤➤➤ All Servers.

2 Click a server name in the list.

Or click Servers ➤➤➤➤ Directory Groups or User-defined Groups, then click a group 
name that contains the server whose information you want to view. Click a server 
name in the list.

3 Depending on the information you want to view, click the System Info, Volume Info, 
Partition Info, or the Alert Settings tabs.

Info type Information available

System Info 
tab

Computer name, MAC address, administrator login name, 
domain, organization, license key, DNS, WINS, computer 
manufacturer, asset code, operating system, machine type, 
amount of RAM, IP address, language, and ping history.

Volume Info 
tab

Server name, ping status, volume name, hard disk size, amount of 
used hard disk space (in megabytes and as a percentage) in the 
volume, amount of unused hard disk space (in megabytes and as 
a percentage), the status of the hard disk, and the file system type.

Partition Info 
tab

Server name, drive number, partition name, file system type, 
partition size, the starting and ending sector, partition status, and 
whether it is a primary or logical partition.

Server Alerts 
Configuration

Server name, ping rate, volume warning and critical thresholds, 
and administrator notification details when thresholds are 
exceeded.

You can make changes to some of the settings displayed on this 
tab. See “Modifying Options for Individual Servers” on page 32.
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Modifying Options for Individual Servers

You can modify alert settings and thresholds for individual servers.

IMPORTANT! Server-specific threshold levels and notify options that are set in this tab 
will take precedence over globally set values in Options.

1 In the left pane, click Servers ➤➤➤➤ All Servers.

2 Click a server name in the list.

Or click Servers ➤➤➤➤ Directory Groups or User-defined Groups, then click a group 
name that contains the server whose information you want to view. Click a server 
name in the list.

3 Click the Alert Settings tab.

4 Specify the ping rate, threshold levels, and notify options that you want to apply to the 
selected server.

The Pager Service and Cell Phone Notification fields will accept e-mail addresses 
for a pager or cell phone. You cannot enter a pager number or telephone number in 
these fields.
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5 Click Save.

You can use Options to set global default threshold levels and notify options that will 
apply to all servers. See “Configuring the Console” on page 35 for more information.

Viewing All Volume Sets

For each server connected to the StorageMonitor web console, you can drill down one 
level from the server view and display information on a volume-by-volume basis.

1 In the left pane, click Server ➤➤➤➤ All Servers.

2 Click the Volumes View tab in the right pane.

All known servers and the volumes within each server are displayed. Total volume 
capacity, including the percentage that is free and used, is also displayed.

The status of disk space used within each volume is indicated with a green (OK), yellow 
(warning), or red (critical) box. The status is based on the threshold levels that you have 
set in Options or in the Alert Settings tab in Server Information.





35

C H A P T E R4
Configuring the Console
This chapter includes the following information:

• Overview

• Setting Default Threshold Levels

• Changing the Default E-mail Notification Address

• Setting the Ping Frequency

• Adding a New User and Password

• Editing Passwords

• Deleting a User and Password
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Overview

You can configure various global settings in StorageMonitor to make it easier to work. For 
example, you can:

• Set the default threshold levels

• Change the default e-mail notification address

• Set the ping frequency

• Add and change password access to StorageMonitor

The setting changes you make are saved and remain effective for all StorageMonitor 
sessions until you change them. Be aware that you must wait for the mail buffer to clear 
before any global default settings you choose are updated. Until the mail buffer clears, it 
may appear as though your settings have not changed.

IMPORTANT! Server-specific threshold levels and notify options that are set in the Alert 
Settings tab will take precedence over globally set values in Options. See 
“Modifying Options for Individual Servers” on page 32 for more 
information.

Setting Default Threshold Levels

You can set a percentage value that specifies when a warning or a critical alarm is issued. 
When hard disk space used by any server volume reaches the specified percentage, an 
e-mail notification is automatically sent by the control server to a recipient (as identified in 
the default e-mail notification address field) indicating a warning or critical alarm has 
been reached. The recipient can act on the alarm as needed.

The status of disk space used within each volume is indicated with a green (OK), yellow 
(warning), or red (critical) box. The status is based on global threshold levels set in 
Options or on server-specific threshold levels set in the Alert Settings tab in Server 
Information. To view the status of a disk on any given server, use the Volume Info tab in 
Server Information.



PowerQuest VolumeManager 37

Setting the Critical Threshold Level

1 Click Options to the right of the StorageMonitor tab.

2 Specify a default threshold percentage value (1-100) in the field next to the red 
(critical) box. 

A typical value for this level is 90.

3 Click Save.

Setting the Warning Threshold Level

1 Click Options to the right of the StorageMonitor tab.

2 Specify a default threshold percentage value (1-100) in the field next to the yellow 
(warning) box.

A typical value for this level is 75. The warning threshold level percentage must be 
less than the critical threshold level percentage.

3 Click Save.
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Changing the Default E-mail Notification Address

You can specify the default e-mail address of the recipient who will receive the alarm 
notification when a critical or warning threshold is reached.

1 Click Options in the upper right corner of the screen.

2 Type the name of the mail server you are using for e-mail in the Mail Server Name 
field.

3 Type the port number of the mail server you are using in the Port Number text field.

4 Specify an e-mail address from which notification of threshold alarms will be sent.

E-mail messages will be sent to the address indicated in the global default alert 
settings or the individual server alert configuration. See “Modifying Options for 
Individual Servers” on page 32 for information about choosing an e-mail address 
where alert notifications should be sent for individual servers. If there is no e-mail 
address specified for an individual server, your setting in this field will determine 
both who the e-mail message is sent from and to whom it is sent.

5 Type the subject that will appear in the subject line area of the e-mail message.

6 Click Save.

Setting the Ping Frequency

You can set the ping frequency, in minutes, that defines how long the control server will 
wait between sending “ping” packets to the specified server. 

1 Click Options in the upper right corner of the screen.

2 Specify the minutes you want in the Ping Frequency field.

A ping frequency of 15 minutes may prevent additional network traffic on the LAN. 
A ping frequency of one or two minutes is preferred if the server not responding is at 
a critical threshold level.

3 Click Save.
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Adding a New User and Password

The administrator can set up the control server to allow password access by multiple users.

1 Click Options to the right of the StorageMonitor tab.

2 Click the Security tab.

3 Click New User.

4 Type a name in the Username field.

5 Type the new password in the Password field.

6 Confirm the new password in the Verify Password field.

7 Click Save.

The username will now appear on the User drop-down list in the Security tab of 
Options.

Editing Passwords

When you installed the control server, it contained a default username and password to 
allow you access to the console the first time. It is recommended that you set your own 
password using your own admin username. You can set up multiple users and passwords.

1 Click Options to the right of the StorageMonitor tab.

2 Click the Security tab

3 Select a username from the User drop-down list.

4 Click Edit.

5 Type a new password in the Password field.

6 Confirm the new password in the Verify Password field.

7 Click Save.
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Deleting a User and Password

1 Click Options in the upper right corner of the screen.

2 Click the Security tab.

3 Select a username from the User drop-down list.

4 Click Delete.
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C H A P T E R5
Editing the ControlCenter ST 
Agent Settings
This chapter includes the following information:

• Getting ControlCenter ST Agent Information

• Changing the General Settings

• Changing the Transport Settings

• Security Settings



Chapter 5: Editing the ControlCenter ST Agent Settings42

Getting ControlCenter ST Agent Information

The ControlCenter ST Agent software that runs on every managed server includes settings 
that you can edit. You can also display agent status information.

1 On the System Tray, click the ControlCenter ST Agent icon.

The ControlCenter ST Agent dialog appears with the following information.

• Server IP shows the address of the control server.

• Interface shows the network protocol being used

• Local IP shows the IP address for the machine where the agent is installed.

• MAC Address shows the media access control address (sometimes referred to as 
the specific network node number).

2 (Optional) Click the Hide when minimized checkbox to hide the dialog.

3 (Optional) Click Minimize on startup to minimize the agent on startup.

4 Click Properties to edit the agent settings.

Information is displayed in tabbed pages. To view a page, click its associated tab, 
which is always visible at the top of the pages.

Changing the General Settings

The General page lets you change the name and maximum size of the file where output 
information from the ControlCenter ST Agent is stored.

1 Check the Save log information to a file checkbox to save the output information 
sent from the agent to a file.

2 In the File Name box, type the name of the file.

3 In the Max Size box, type the maximum size you want the file to be.

4 Click OK to apply the settings.

You can also set a password to protect the agent settings.

1 Choose the Password Protect checkbox to password protect the settings on the agent 
machine.
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Changing the Transport Settings

The Transport page lets you specify the way the agent machine obtains the IP address of 
the control server.

1 Choose either DHCP or Static IP Address.

2 (DHCP) In the Option Number box, type an option number.

When configuring the DHCP server, the administrator will select a DHCP option 
number that the agent sends to the DHCP server as a request type. This option number 
tells the DHCP server to send the IP address of the control server to the machine 
running the agent.

(Static IP Address) In the Address box, type the IP address of the control server.

3 Click OK to apply the settings.

Security Settings

You should disregard the Security settings tab. The settings do not apply to ControlCenter 
ST for StorageMonitor.
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Introduction
With PowerQuest® VolumeManager™, you can quickly and easily create and modify 
hard disk partitions. You can also use VolumeManager to copy, resize, move, reformat, 
delete, or consolidate volume sets. Storing information in separate partitions helps you 
organize and protect your data and reclaim wasted disk space.

VolumeManager enables you to secure your data by physically separating it from other 
files. Separate partitions also make backups easier.

VolumeManager also includes Remote Agent, a DOS application that enables you to 
perform operations across the wire on remote servers.

In addition to powerful partitioning features, VolumeManager offers a variety of other 
options. You can perform partitioning operations and view the changes that will be made 
before applying them to your system. Additionally, you can view comprehensive 
information about your hard disk geometry and your hardware system.





49

C H A P T E R6
VolumeManager Basics
This chapter includes the following information:

• Before Running VolumeManager

• Running VolumeManager from Windows

• Running VolumeManager from Rescue Disks

• Setting a Password for VolumeManager

• Process Overview

• Selecting a Hard Disk

• Selecting a Volume Set

• Selecting an Operation

• Undoing an Operation

• Viewing Pending Operations

• Applying Changes to Your System

• Supported File Systems

• Changing VolumeManager Preferences

• Using International Keyboards

• Getting Help



Chapter 6: VolumeManager Basics50

Before Running VolumeManager

Before the start of a VolumeManager session, you should always complete the following 
items:

• Apply the most recent Windows NT/Windows 2000 service pack

Make sure you have applied the most recent service pack when running either 
Windows NT or Windows 2000.

• Back up your hard disk

You should back up your hard disk before using VolumeManager. While 
VolumeManager has been thoroughly tested to be safe and reliable, other factors, 
(such as power failures, operating system bugs, and hardware defects), can put your 
data at risk. Before using any utility that makes extensive changes to your hard disk, 
you should back up your data.

• Back up BOOT.INI

Before you modify the hard disk that contains the boot partition, back up the 
BOOT.INI file. If the disk contains the boot partition, the BOOT.INI file may be 
changed.

• Shut down all applications

You should not run VolumeManager with other applications, including virus 
scanners.

• Run Check for Errors option regularly

Before you manipulate any partitions or volume sets, you should always click 
Operations ➤ Check for Errors. Although VolumeManager checks partitions and 
volume sets for errors and can repair minor problems, more serious errors could cause 
VolumeManager to abruptly end an operation.

Check for Errors can find and fix most common errors you will encounter. The Check 
for Errors option is dimmed (unavailable) on the Windows NT boot partition because 
there are always open files. For this partition, click Operations ➤ Windows 
CheckDisk. If errors are found, run CHKDSK /F from a command prompt to fix 
them before running VolumeManager.

• Take the server offline

Having connected clients to the server increases the likelihood that VolumeManager 
will have to reboot the computer to perform an operation. You may want to consider 
scheduling VolumeManager sessions for off hours and notify clients that the system 
will be unavailable during that time.
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Or, if you must make changes during regular business hours and there are users 
connected to the server, VolumeManager will give you the option to disconnect all 
users from the server.

• Create a Windows NT boot disk

The boot disk lets you boot Windows NT if your BOOT.INI file points to the wrong 
boot partition. For information about creating a boot disk, refer to the Microsoft 
Knowledge Base on the Internet, article Q119467, “Creating a Boot Disk for an 
NTFS or FAT partition.”

• Connect to a UPS (Uninterruptible Power Supply)

VolumeManager may not be able to recover if a power failure occurs during 
repartitioning. By having the server and all connected hard drives protected by UPSs, 
you can avoid the problems caused by power failures.

• Disable virus protector services and SNMP terminal server services

Running VolumeManager from Windows

IMPORTANT! VolumeManager must be run from a local drive, not from a network drive.

1 Click Start ➤ ➤ ➤ ➤ Programs ➤ ➤ ➤ ➤ PowerQuest VolumeManager 2.0 ➤ ➤ ➤ ➤ VolumeManager 
2.0.

If you attempt to run VolumeManager on a Windows 2000 machine where the boot 
partition (the partition where Windows 2000 is installed) is on a dynamic disk, you will 
receive the following error message: “Init failed: Error 183. Unable to identify the 
Windows partition.” To remedy this problem, you must place the boot partition on a basic 
disk.

VolumeManager Main Window

The main window includes an Explorer-like tree view of the disks or volumes on your 
server, a map of each disk or volume, and a list of the partitions on the selected disk or 
volume. You control whether the screen displays disks or volumes by clicking the Disks or 
Volume Sets tab in the Explorer pane.

The menu bar and a toolbar appear at the top of the window. The menu bar gives you 
access to all of VolumeManager’s features. When you choose a menu command, the status 
bar at the bottom of the screen shows what the command does. The toolbar gives you 
quick access to commonly used options. When the pointer is over a toolbar, the status bar 
shows what the button does.
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Note that the main screen is different if you run VolumeManager from the rescue disks. 
See “Rescue Disk Main Window” on page 56.

Disk View

Volume View

Triangles

Menu Bar
Toolbar

Status Bar

Disks View

Partition Map 
(scrollable to 
display all 
disks)

Partition List

Legend
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Partition Information

The partition area displays information about the selected hard disk’s partitions. It consists 
of two areas: the partition map, which displays information graphically; and the partition 
list, which displays partition information in text form.

Partition Map 

The partition map shows the partitions approximately to scale. (You can also display disks 
to scale by clicking View ➤ Scale Disk Map.) If the selected hard disk contains logical 
partitions, the logical partitions are shown within an extended partition.

Each partition is color-coded to show the file system it uses and the used and unused space 
within the partition. Note that the operations you can perform on white (unformatted) or 
yellow (unknown) partitions are limited. A legend at the bottom of the screen shows which 
file system each color represents.

The partition map also shows unallocated space (space not assigned to any partition).

There are triangle indicators to mark the 2 GB boot boundary and the 1024 cylinder limit. 
The boundary markers can help you as you create, move, or resize partitions, so you will 
not make primary partitions unbootable by accident. For additional information about the 
boot boundaries, refer to “Understanding the BIOS 1024 Cylinder Limit” or 
“Understanding the 2 GB Boot Code Boundary” in the VolumeManager online help.

Partition List 

The partition list displays the following information about each partition: drive letter, 
volume label, file system type, size, amount of used and unused space, status, and whether 
the partition is a primary or logical partition.

Primary partition drive letters are flush left, followed by a colon and the volume name. 
Logical partition drive letters and volume labels are indented. An asterisk (*) appears in 
place of a drive letter for:

• Hidden partitions 
• Extended partitions 
• Partitions with file systems not supported by the active operating system
• Unallocated space 

The partition size, used space, and unused space values are displayed in megabytes.
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A partition’s status can be:

• Active: The partition the computer boots from.

• Hidden: Under Windows NT, hidden partitions do not have a drive letter. Partitions 
can be hidden by the operating system (which may hide all primary partitions except 
the active one), or you can hide partitions with VolumeManager. Under Windows 
2000, hidden partitions are allowed to have a drive letter.

• None: Partitions that are not active or hidden.

Wizards

To help you quickly and easily complete several common partitioning tasks, 
VolumeManager includes these wizards:

• Create new partition
• Redistribute free space
• Resize partitions
• Merge partitions
• Copy partition

To start a wizard, click the wizard icon or choose a command on the Wizards menu. For 
more information about using the wizards, see “Wizard Overview” on page 130. 

You do not have access to the wizards if you run VolumeManager from the rescue disks.

Running VolumeManager from Windows Explorer

1 From Windows, click Start ➤ Programs ➤ Windows Explorer.

The Exploring window appears.

2 Right-click on any drive object.

A quick menu appears.

3 Click VolumeManager 2.0.

The program loads, and the VolumeManager main window appears.

Running VolumeManager from My Computer

This option lets you start VolumeManager from My Computer.

1 Double-click on the My Computer icon.

The My Computer menu appears.
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2 Right-click on any drive object.

A quick menu appears.

3 Click VolumeManager 2.0.

The program loads, and the VolumeManager main window appears.

You can also right-click on the My Computer icon to access the quick menu.

Running VolumeManager from Rescue Disks

Create Rescue Disks is a wizard that helps you create diskettes you can use to boot your 
computer and run VolumeManager for DOS (VMDOS .EXE). Rescue disks are useful 
when:

• You have hidden the partition where VolumeManager is installed and need to run 
VolumeManager to unhide the partition.

• You have accidently converted a partition to FAT32 and your operating system does 
not support FAT32, so your computer will not boot. (You can use the rescue disks to 
convert the partition back to FAT.)

• Other occasions arise when you do not have access to VolumeManager on the CD or 
hard drive.

When you boot your computer from the first rescue disk, VMDOS automatically runs. 
You must insert the second rescue disk when prompted. The main screen appears different 
when you run VolumeManager from rescue disks than it does when you run 
VolumeManager from Windows. See “Rescue Disk Main Window” on page 56.

If you run VolumeManager from the rescue disks, you will not have access to the 
following features:

• Volume management (Volume Set view)
• Remote Agent (across the wire)
• ScriptBuilder
• Split partitions
• Shred partitions
• Undelete partitions
• Undo last change
• Wizards
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Before you run VolumeManager from DOS, you should:

• Turn off third-party disk caches.
• Deactivate/unload any TSR programs that access or modify partitions being changed.

Do not run VolumeManager from a compressed drive.

Checking an NTFS partition with the DOS version of VolumeManager may take an 
unusually long time. Since VolumeManager performs checks both before and after the 
move, copy, and resize operations, these operations may be slower with the DOS version 
of VolumeManager than with the Windows version.

IMPORTANT! The number of computers on which you can run the DOS-based version of 
VolumeManager is specified in your VolumeManager license agreement. 
Refer to your license agreement before using a rescue diskette.

Rescue Disk Main Window

The main screen appears different when you run from rescue disks than it does when you 
run VolumeManager from Windows NT.

• Menu bar — gives you access to all of VolumeManager’s features.

• Toolbar — gives you quick access to commonly used options.

• Partition information — provides both a visual and text description of the partitions 
on the disk.
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• Status bar — shows you how many operations are pending; also includes a brief 
description of the currently selected option.

Running a Script from the Rescue Disks

You can modify the rescue disks to run VolumeManager with a script file automatically.

You can create script files with ScriptBuilder or in Notepad or any text editor. For 
examples of script files and further information about VolumeManager scripting 
commands and syntax, refer to the VMSCRIPT.PDF file in the English/Docs folder on the 
VolumeManager CD or the VolumeManager ScriptBuilder online help.

1 Open the AUTOEXEC.BAT file on VolumeManager 2.0 Disk 1.

2 Edit the line that includes VMDOS as follows, where SCRIPT.TXT is the name of the 
script file you want to execute:

VMDOS /CMD=SCRIPT.TXT

IMPORTANT!Do not include a hard return at the end of the line that includes the 
VMDOS command. Do not make any other modifications to the 
AUTOEXEC.BAT file.

3 Save the AUTOEXEC.BAT file.

4 Copy the AUTOEXEC.BAT file to VolumeManager 2.0 Disk 2.

Menu Bar

Toolbar

Partition Map

Status Bar

Partition List
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The file must be identical on both disks, or VolumeManager will not function 
properly.

5 Copy the script file to VolumeManager 2.0 Disk 2.

When you boot from the first disk, VolumeManager will execute the script file you 
specified. See “Scripting” on page 132 or the VolumeManager help.

Setting a Password for VolumeManager

You can assign a password that must be entered before volumeManager will start.

1 Click General ➤ Set Password.

The Set Password dialog box appears. 

2 Type a new password, then press <Tab>.

3 Confirm the new password, then press <Tab>.

4 (Optional) Add a hint.

5 Click OK.

Each time you start VolumeManager, you will be prompted for a password before the 
program will run.

Entering a Password

When you start VolumeManager and there is a password assigned, the Enter Password 
dialog appears.

1 Type the password assigned to VolumeManager.

You can click Hint to display a reminder. If you still cannot remember the password, 
refer to documentation for error 996 on page 165.

2 Click OK.

Changing a Password

1 Click General ➤ Set Password.

2 Type the old password, then press <Tab>.
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3 Type the new password, then press <Tab>.

4 Confirm the new password, then press <Tab>.

5 (Optional) Change the hint.

6 Click OK.

Removing Password Protection

1 Click General ➤➤➤➤ Set Password.

2 Type the old password, and leave the remainder of the fields blank.

3 Click OK.

Process Overview

To complete a task, follow this general process:

1 Select a hard disk and partition, or select a volume set.

2 Select an operation and enter details about the changes you want to perform.

3 Apply changes to your system.

You can also perform some tasks using the wizards. Refer to “Automating Tasks” on page 
129 for information about the wizards.

Note that the steps for selecting a hard disk and partition or a volume are included in this 
chapter of the user guide. You must follow these steps before you can perform any 
operation within VolumeManager.

Selecting a Hard Disk

Before you can select a disk, you must click the Disks tab in the tree view or click View ➤ 
Disks. There are three ways to select a hard disk:

• In the tree view on the left side of the main window, click the icon for the disk. If the 
tree view is not displayed, click View ➤ Tree View.

• On the disk map, click the title bar for the disk. You may need to scroll through the 
disk map area if you have several hard disks on your server.



Chapter 6: VolumeManager Basics60

• From the Disks menu, choose the disk you want.

When you select a disk, its partitions display in the partition list in the main window.

Using VolumeManager with Removable Media

VolumeManager is not designed to work on removable media. PowerQuest technical 
support does not guarantee they will be able to resolve problems you encounter when 
partitioning removable media.

Windows 2000 Disks

Windows 2000 uses basic disks and dynamic disks. You cannot perform VolumeManager 
operations on dynamic disks.

Selecting a Partition 

Before you select a partition, click the Disks tab in the tree view. There are three ways to 
select a partition:

• In the tree view on the left side of the main window, click the partition. If the tree 
view is not displayed, click View ➤ Tree View.

• On the disk map, click the partition. You may need to scroll through the disk map area 
if you have several hard disks on your server.

• In the partition list, click the partition.

The selected partition is highlighted in all three locations. 

If Remote Agent is running, you can select a partition on a remote server. See “Remote 
Agent” on page 133.

Selecting a Volume Set

Before you can select a volume set, you must click the Volume Sets tab in the tree view or 
click View ➤ Volume Sets. There are two ways to select a volume:

• In the tree view, click the volume.

• In the volume map, click the volume.

The segments for the selected volume display in the segment list.
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The volume set must reside on a hard disk attached to a Windows NT 4.0 server. You 
cannot use VolumeManager to manipulate a volume set that was converted from Windows 
NT Server to Windows 2000 Server.

Selecting an Operation

After you have selected a partition or volume, you can select an operation using the 
toolbar, the context menu, the menu bar, or the keyboard. If an operation cannot be 
performed on the selected partition or volume, the operation appears dimmed on the menu.

• Click one of the operations buttons on the toolbar. 

When you place the pointer on a toolbar button, a pop-up window displays the 
button’s function.

• In the partition map or partition list, right-click the partition or volume segment you 
want to change, then click the desired operation on the context menu.

• On the menu bar, click Operations, then choose the desired operation. 

• Press <Alt+O>, then type the underlined letter of the desired operation.

For more information about the items on the Operations menu, see Chapters 7 through 10 
of this user guide.

Undoing an Operation

There are three ways to undo or reverse the last operation performed:

• Click on the toolbar.

• Click General ➤ Undo Last Change on the menu bar.

• Press <Ctrl+Z>.

If you have performed an operation using a wizard, Undo Last will undo all the changes 
made by the wizard.

To discard all the changes performed and start over, click General ➤ Discard all 
Changes, or press <Ctrl+D>. 
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Viewing Pending Operations

VolumeManager queues operations until you apply them. You can view the operations that 
are pending at any time.

1 Click Operations ➤ View Operations Pending.

The Operations Currently Pending dialog appears.

From the list of pending operations, you can choose to undo the last change, discard 
all changes, apply all changes, or close the window.

If you are running VolumeManager from the rescue disks, you cannot modify 
pending operations from this window.

Applying Changes to Your System

As you complete tasks using the Operations menu, the partition map and partition list 
reflect the changes you have made. However, no changes physically take place on your 
system until you apply them. You can perform several operations and then apply all the 
changes at once.

You can tell when changes have been made but not yet applied to your system when the 
status box in the lower right corner of the main window indicates that operations are 
pending. If the wizard icons are displayed, the Apply Changes and Undo Last icons also 
display at the bottom of the window when there are operations pending.
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To apply changes to your system, click General ➤ Apply Changes, or click  on the 
toolbar. If the wizard icons are displayed, you can also click the Apply Changes icon at 
the bottom of the window. If you have open files, VolumeManager may need to reboot 
your computer and apply the changes in boot mode.

You can click Apply Changes ➤ Details to view a list of the operations that will be 
applied.

To discard the changes and start over, click General ➤ Discard All Changes. With the 
exception of being able to undelete some partitions, you cannot discard or undo changes 
after you have applied them.

Forcing Users to Log Off

Before VolumeManager can apply any changes from within the VolumeManager program, 
it must have exclusive use of the system disk drives (no users logged on). If any users are 
connected to the server, VolumeManager will prompt you to do one of the following when 
applying changes:

• Click Yes to automatically disconnect remote users from the system, disable future 
logons, and apply changes. Several services are stopped. After applying the changes, 
VolumeManager restarts the stopped services and remote users are again allowed 
access to the server.

The system administrator should notify users and allow them to log off before 
selecting Yes.

• Click No to stop the operation. VolumeManager will not apply changes or disconnect 
remote users.

• Click Ignore to apply changes without automatically disconnecting remote users.  
Under this condition, if VolumeManager cannot get control of the required drives or 
volumes, it will reboot your server to apply the changes in boot-mode.

Since Windows NT always has some open files, if you make changes to the partition 
containing the Windows NT operating system (or any partition which uses files from the 
Windows NT operating system) without logging off the users, you will need to reboot 
your system. However, if you make changes to a partition that does not share any 
Windows NT files, you do not need to log off remote users and your system generally will 
not need to be rebooted. For example, if you create a new partition in unallocated space, 
you do not need to log off the remote users before applying the change.
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Administrative Shares

When you create, delete, move, format, merge, copy, or hide an NTFS or FAT partition, 
VolumeManager applies or deletes (depending on the function performed) administrative 
shares for the partition. This allows administrators remote access to the partition without 
having to reboot the server first.

Supported File Systems

IMPORTANT! VolumeManager does not generally support stripe sets, stripe sets with 
parity, or partitions located on disk mirror/duplex sets configured using 
Windows NT Disk Administrator. However, you can resize partitions that 
are part of a mirrored/duplexed set. On Windows 2000, VolumeManager 
supports standard partitions located on basic disk sets only.

VolumeManager supports the following partition types.

Partition 
Type Description

Extended The extended partition gets around the arbitrary four-partition limit 
for a disk. An extended partition is a container in which you can 
further divide your disk space by creating logical partitions. An 
extended partition does not directly hold data. You must create logical 
partitions within the extended partition to store data.

Extended-X An extendedx partition functions like an extended partition but is not 
limited to the first 1024 cylinders on a drive.

Linux kernels below 2.2 do not support Extended-X partitions.

FAT Uses file allocation table (FAT) and clusters. The FAT file system is 
used by DOS, Windows 3.x, and most Windows 95 installations. A 
FAT partition is also accessible by Windows 98/Me/NT/2000 and by 
OS/2.

FAT16x FAT16x is a proprietary file system developed by Microsoft to enable 
FAT partitions beyond 1024 cylinders (~8GB).
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FAT32 FAT32 is an enhancement of the FAT file system. It uses 32-bit file 
allocation table entries, rather than the 16-bit entries used by the FAT 
system, so FAT32 supports larger disk or partition sizes (up to 2 
terabytes). The minimum size for a FAT32 partition is 256 MB.

A FAT32 partition is only accessible by Windows 95 OSR2 (version 
4.00.950B), Windows 98/Me/2000. However, DOS, Windows 3.x, 
Windows NT 3.51/4.0, earlier versions of Windows 95, and OS/2 do 
not recognize FAT32 and cannot use files on a FAT32 partition.

FAT32x FAT32x is a proprietary file system developed by Microsoft to enable 
FAT32 partitions beyond 1024 cylinders (~8GB). Windows 95 OSR2, 
and Windows 98/Me/2000 may use FAT32x partitions.

HPFS The High Performance File System (HPFS) is accessible only by 
OS/2, older versions of Windows NT (v. 3.51 and earlier), or versions 
of Windows NT that were upgraded from v. 3.51 or earlier. 

HPFS/386 HPFS/386 is a file system used by OS/2 Advanced Server. The only 
difference from HPFS is that HPFS/386 uses Access Control Lists 
(ACLs), and HPFS does not. In both file systems, each file and 
directory structure is anchored on a structure called an fnode. In 
HPFS/386, each fnode has internal storage space for ACLs and 
Extended Attributes. If a file has more than 16 ACLs, they are stored 
outside of the fnode on disk, and the fnode has a pointer telling where 
to find the ACLs.

Linux Ext2 The Linux Ext2 file system is only accessible by Linux, a freeware 
version of UNIX. The Linux Ext2 file system supports a maximum 
partition size of 4 terabytes. 

Linux Swap Holds a Linux swap file. The maximum usable size of a Linux swap 
file is 2 GB. The default size shown when you create a Linux swap 
partition may be slightly larger because of the physical geometry on 
the hard disk.

NTFS The NTFS (New Technology File System) is accessible only by 
Windows NT and Windows 2000. NTFS is not recommended for use 
on partitions less than 400 MB because it uses a great deal of space 
for system structures.

Partition 
Type Description
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Changing VolumeManager Preferences

1 In the main window, click General ➤ Preferences.

A check mark next to a preference indicates it is enabled.

2 Click checkboxes to enable or disable preferences, then click OK.

Allow 64K FAT Clusters for Windows NT/Windows 2000

This preference lets you create FAT partitions with 64 K clusters, which allows you to use 
VolumeManager to create FAT partitions up to 4 GB. The proprietary Windows NT 64 K 
FAT partition was created by Microsoft for administrators who intended to upgrade the 
partition to NTFS. Converted 64 K FAT partitions retain their cluster size and provide 
faster terminal server function. However, you should not generally use 64 K partitions for 
the operating system.

Unformatted Unformatted partitions reserve a portion of the disk but are not 
assigned a file structure.

Unallocated 
space

Unallocated space is the portion of a hard disk that is not currently 
assigned to any partition.

Partition 
Type Description

Indicates 
whether the 
current 
operating 
system 
supports FAT32 
partitions.
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IMPORTANT! Because DOS, Windows 3.x/95/98/Me do not support cluster sizes larger 
than 32K, you cannot access a 64K partition using these operating systems. 
You should only use 64K partitions with Windows NT and Windows 2000. 
If you are using multiple operating systems, PowerQuest recommends not 
using 64K clusters.

When enabled, the 64K cluster size is available in the Resize/Move Partition and Resize 
Clusters dialogs.

Ignore OS/2 EA Errors on FAT

This preference tells VolumeManager whether to ignore OS/2 Extended Attribute errors 
when it checks a FAT partition.

WARNING! If OS/2 is on your computer, do not enable this preference. Data loss could 
occur because problems might go undetected.

Skip Bad Sector Checks

When VolumeManager modifies partitions, it performs extensive testing to detect bad 
sectors on your hard disk. Newer disk types (such as Enhanced IDE and SCSI) often 
handle bad sectors internally, making such testing superfluous. For this reason, 
VolumeManager lets you bypass these tests with Skip Bad Sector Checks. When this 
preference is enabled, the Resize/Move, Create, Copy, and Format operations run faster.

WARNING! If you skip bad sector checks and your hard disk has bad sectors, data loss 
can result.

Bad sector checking is on by default. VolumeManager lets you set this preference 
individually for each of your hard disks. If your system has an older disk and a newer one, 
you could check the older disk and skip the newer one. A check mark next to a disk means 
to skip bad sector checking for that disk. 

Set as Read-Only for VolumeManager

This preference lets you prevent VolumeManager from making any changes to a hard disk. 
You can set this preference individually for each of your hard disks.

If the disk contains the boot partition, some files may be changed, such as the Windows 
NT boot initialization (BOOT.INI) file.
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Changing Drive Letters

Do not change the drive letter of your Windows NT or Windows 2000 boot partition to 
anything other than its original designation. Doing so will cause some services to fail upon 
reboot and may render your server unbootable.

Using International Keyboards

When you use the DOS version of VolumeManager (see “Running VolumeManager from 
Rescue Disks” on page 55), you may lose the ability to use your keyboard the way you are 
accustomed to or to view extended characters properly. The VolumeManager rescue disks 
include the files you need to resolve these problems.

If you use an international keyboard or character set, you must edit the AUTOEXE2.BAT 
and CONFIG.SYS files on the rescue disks.

1 The following lines are remarked in the AUTOEXE2.BAT file. Delete the REM from 
the beginning of the line, and replace the variables xx and yyy with the keyboard 
code and character set code page for your language.

MODE CON CP PREP=((yyy)EGA.CPI)
MODE CON CP SEL=yyy
KEYB xx,yyy

xx = two-letter keyboard code (for example, US or FR)
yyy = character set code page (for example, 437)

2 Save the AUTOEXE2.BAT file.

3 The following line is remarked in the CONFIG.SYS file. Delete the REM from the 
beginning of the line, and replace the variable yyy with the character set code page 
for your language.

DEVICE=DISPLAY.SYS CON=(EGA,yyy,)

4 Save the CONFIG.SYS file.

5 Reboot from the first rescue disk.
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Getting Help

VolumeManager Help provides in-depth information on features as well as step-by-step 
instructions for specific tasks.

To access Help, click Help ➤ Contents on the menu bar in the VolumeManager main 
window.

The PowerQuest VolumeManager Help is organized into books and pages.

Each book focuses on a different aspect of VolumeManager, so you can quickly locate the 
information you need. When you double-click a topic, the information displays in the right 
window.

You can click the key tab to search for a topic using keywords.

Context-Sensitive Help

By clicking Help in the lower right corner of a dialog, you can open context-sensitive help 
for the dialog. Clicking Hints in a wizard dialog displays helpful information about the 
task the wizard is performing.

Readme File

The READMEVM.TXT file includes information that changed since this guide was 
written, corrections to the manual or help system, and information specific to installation 
or configuration issues.

Find information 
with the Index 
(key) and Find 
(binoculars) 
tabs.

Double-click a 
page to read 
the help topic.

Double-click a 
book to view the 
pages in it.
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C H A P T E R7
Completing Disk Operations
This chapter includes the following information:

• Integrity Checks

• Resizing and Moving Partitions

• Creating Partitions

• Deleting Partitions

• Undeleting Partitions

• Changing Partition Labels

• Formatting Partitions

• Copying Partitions

• Checking Partitions for Errors

• Merging Partitions

• Splitting Partitions

• Getting Information About Partitions

• Scanning a Disk for Errors

IMPORTANT! Before you perform any operations in VolumeManager, you 
should be familiar with the material explained in 
“VolumeManager Basics,” which begins on page 49.
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Integrity Checks

VolumeManager checks disk integrity with a sophisticated system of analysis and 
validation that operates behind the scenes every time you start the program or complete an 
operation. An initial integrity check scans your disk and reports any partition problems 
that may prevent VolumeManager from operating properly. This integrity check acts as an 
early warning system that informs you of your disk’s status and assures that the disk’s 
structure is thoroughly analyzed and verified before you alter it.

If your physical disk passes the initial integrity check, you can select the disk’s partitions 
and use VolumeManager’s options; otherwise, an error message appears instead of the 
partition list. This indicates a problem with your disk, not with VolumeManager (because 
no disk modification operations have been initiated). If VolumeManager finds errors that it 
can fix automatically, you will be prompted. It is safe to allow VolumeManager to fix 
errors. Correct the disk problem, and then restart VolumeManager. For additional 
information, see “Resolving Partition Table Errors” on page 151.

In addition to the integrity check at startup time, VolumeManager performs two integrity 
checks during any operation. The first check tests the integrity of the file system in the 
partition before an operation begins (similar to CHKDSK), and the second check validates 
your disk’s data after an operation is completed. From start to finish, VolumeManager 
examines your disk and informs you immediately if it detects any irregularities.

Resizing and Moving Partitions

The Resize/Move operation lets you change the size of a partition and/or move it to 
another location on a hard disk.

For information about resizing or moving volume sets, see “Managing Volume Sets” on 
page 105.

1 Select the partition you want to resize/move.

You cannot move Windows NT volume or stripe sets with parity created by Disk 
Administrator.

To move a volume segment, see “Moving Volume Segments” on page 115.

2 Click Operations ➤ Resize/Move.
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The Resize/Move Partition dialog appears.

The current size of the partition is shown on a partition map at the top of the dialog. 
The map also depicts the used (dark gray) and unused (green) space within the 
partition and the unallocated space surrounding the partition (if any exists). The 
minimum and maximum sizes to which you can resize the partition appear below the 
map. 

3 Choose whether to resize or move the partition.

To do this: Do this:

Move 1 Place the pointer on the partition. 

The pointer changes to .

2 Drag the partition to the desired location.

There must be unallocated space adjacent to the partition to move 
it. If there is none, and the partition contains unused space, make 
the partition smaller and then move the partition.

You cannot move unknown partitions, partitions failing the Check 
for Errors operation, or unallocated space.

Unallocated 
space 
outside 
partition

Left 
partition 
handle
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If you know your disk has no bad sectors, Skip bad sector checks in Preferences to 
make Resize/Move operations faster. 

3 (Optional) Click the Cluster Size drop-down list and select a new size.

Move 
(continued)

The beginning of your Windows NT system partition cannot be 
moved past 4 GB, or Windows NT will not be bootable.

IMPORTANT! Exercise caution when moving a bootable 
partition. Operating systems can become 
unbootable if moved beyond certain boundaries. 
For more information, see “Creating Bootable 
Partitions” on page 79. If your operating system is 
unbootable, you can boot from the rescue disks.

Resize 1 Place the pointer on the left or right partition handle. 

The pointer changes to .

2 Drag the handle until the desired partition size is reached.

You can also resize the partition by typing new values in the Free 
Space Before, New Size, and Free Space After boxes or by 
clicking the arrows next to the boxes. The values you enter may 
change slightly to values supported by the drive’s geometry. The 
arrow buttons resize the partition by the minimum increment, 
allowing you to make very fine adjustments. Changes are 
reflected in the partition map. 

To make a partition smaller, unused space must exist within the 
partition. To enlarge a partition, there must be unallocated space 
adjacent to it. For additional information about resizing 
partitions, refer to “Notes about Resizing Partitions” below.

IMPORTANT! Resizing your NTFS system partition over 7.8 GB 
may render your server unbootable. If you resize 
an NTFS system partition over this limit by 
accident, you can recover your system by using 
the VolumeManager rescue disks to resize the 
NTFS system partition below 7.8 GB.

To do this: Do this:
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VolumeManager changes the Free Space Before, New Size, and Free Space After 
values to show how the partition size is affected.

This option is only available for FAT and FAT32 partitions. For more information, 
see “Resizing Clusters” on page 102.

4 Click OK.

Notes about Resizing Partitions

When you resize a partition, data is consolidated, not compressed. To make a partition 
smaller, unused space must exist within the partition. To enlarge a partition, there must be 
adjacent unallocated space. If there is unallocated space on the disk, but it is not adjacent 
to the partition you want to enlarge, adjust the location of the space by moving other 
partitions.

IMPORTANT! Exercise caution when resizing partitions smaller, especially a partition 
containing an operating system. Leave at least 50 MB more space in the 
partition than the operating system requires. Swap files, drivers, and other 
files may require the extra space. Additionally, operating systems can 
become unbootable if moved beyond certain boundaries. For more 
information, see “Creating Bootable Partitions” on page 79.

Resizing FAT and FAT32 partitions smaller may reduce the amount of wasted space on a 
hard disk. When you resize a FAT or FAT32 partition, VolumeManager automatically 
resizes the clusters to their optimal size for the partition. For more information, see 
“Resizing Clusters” on page 102.

You should be aware of the following limitations when resizing partitions:

• You cannot make a partition smaller unless it contains unused space. You can only 
reduce a partition to the used size shown in the partition map plus a small buffer area. 
During a Resize/Move operation, data is consolidated to the front of the partition as 
needed, but no data compression takes place. Because of the way a FAT partition is 
structured, you can often resize a partition a second time and make it even smaller or 
larger than the first time you resized it.

• In certain instances, you cannot make a FAT partition larger when the partition 
contains no unused space. If you have a full partition and plenty of unallocated space 
adjacent to it, yet are not able to enlarge your partition, you may have to delete some 
files in the partition so that VolumeManager has room to work. You may be able to 
slightly enlarge the partition (1 MB or less) and then enlarge the partition a second 
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time to provide the necessary buffer area for VolumeManager. To see how much 
space is needed in a partition to resize past a cluster boundary, see the table in 
“Freeing Disk Space Before Enlarging a FAT Partition” in Help.

• It is difficult to calculate in advance the minimum size to which an NTFS or HPFS 
partition may be resized. During an NTFS or HPFS Resize/Move operation, if 
VolumeManager runs out of space, it returns an error without completing the 
operation. The integrity of the NTFS or HPFS partition and data is never 
compromised.

Resizing Partitions in Mirrored Sets

VolumeManager does not support any partitions located in mirrored sets configured using 
Windows NT Disk Administrator. However, you can use VolumeManager to ultimately 
manipulate the size of a mirrored set.

1 Use Windows NT Disk Administrator to break the mirrored set.

Select the primary mirror, then click Partition ➤ Break Mirror. Delete the old 
partition.

You will have to reboot your server.

2 Use VolumeManager to change the size of the master portion of the previously 
mirrored set.

3 Use Disk Administrator to re-establish the mirror.

Select the primary mirroring partition. While holding down the Ctrl key, select 
unallocated space with the mouse. Click Partition ➤ Create Mirror.

Creating Partitions

The Create operation lets you create primary partitions, extended partitions, and logical 
partitions.

If you have multiple hard disks and partitions, the process and available options may differ 
slightly from the following steps. 

1 Select a block of unallocated space.

If no unallocated space exists, you must resize or delete an existing partition to create 
unallocated space. For instructions on resizing and deleting partitions, see “Resizing 
and Moving Partitions” on page 72 and “Deleting Partitions” on page 80.
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If Remote Agent is running, you can create a partition on a remote server.

On a single hard disk, you can have up to four primary partitions or three primary 
partitions and one extended partition. Within an extended partition, you can create 
unlimited additional subdivisions called logical partitions. 

2 Click Operations ➤ Create.

The Create Partition dialog appears.

3 From the Create as drop-down list, select Logical Partition or Primary Partition.

You should create primary partitions to install operating systems and logical 
partitions for all other purposes (such as storing data and applications). If you have 
multiple hard disks, you can improve speed by installing operating systems and 
applications on separate disks. If you do not know what type of partition you want to 
create, see “Understanding Partitions” in Help.

You should create a primary partition if you plan to install an operating system. Refer 
to “Creating Bootable Partitions” on page 79.

If you select Logical Partition, VolumeManager automatically creates an extended 
partition to enclose the logical partition, or, if you already have an extended partition, 
resizes the extended partition larger to encompass the logical partition (the free space 
must be inside of or adjacent to the extended partition).

If Logical Partition is unavailable, you may already have four primary partitions on 
the hard disk. Or, if you have an extended partition, you may not have selected a 
block of free space inside of or adjacent to the extended partition.

If you create a second, third, or fourth primary partition on a physical disk, 
VolumeManager will create the new primary partition as unhidden. However, 
VolumeManager will automatically hide the other primary partitions on that disk 
when performing a Set Active operation.
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4 From the Partition Type drop-down list, select the desired file system type:

FAT is the most common file system type. It is used by DOS, OS/2, and all versions 
of Windows.

FAT32 is used by Windows 95 OEM Service Release 2, Windows 98, Windows Me, 
and Windows 2000.

HPFS is used by OS/2 and Windows NT 3.51 (and earlier versions).

NTFS is used by Windows NT and Windows 2000.

Linux Ext2 and Linux Swap are used only by Linux.

Extended creates an extended partition which can contain any number of logical 
partitions. Extended is not an option if the hard disk already contains an extended 
partition or four primary partitions.

Unformatted creates an unformatted partition on your hard drive.

5 (Optional) Enter a label (up to 11 alphanumeric characters for FAT and 32 
alphanumeric characters for NTFS) for the new partition.

6 In the Size box, enter the desired size for the partition.

VolumeManager automatically calculates a recommended size (based on the most 
efficient use of disk space), which you can accept or change.

7 If the size you specified for the new partition is smaller than the available unallocated 
space, you can position the partition at the beginning (recommended) or end of the 
unallocated space. In the Position box, click Beginning of free space or End of free 
space.

8 In the Drive Letter box, type or select the drive letter you wish to assign to the 
partition.

9 Click OK. 

WARNING! Because of conflicts that can result from different hardware and system 
configurations, do not create a partition on a hard disk and then move that 
hard disk to another computer. Data loss may occur.
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Creating Bootable Partitions

Before creating a partition where you plan to install an operating system (a bootable 
partition), you should understand the information outlined in the following table.

IMPORTANT! When you create, move, or resize a bootable partition, the partition must 
begin below the boot code boundary specified in the above table in order 
for the operating system to boot. With the exception of DOS 6.22 (or 
earlier) and OS/2, partitions beyond 8 GB are visible to the current 
operating system. For more information, see “Understanding the BIOS 

Operating System

Boots from 
Primary or 
Logical

Supported 
Partition Types

Boot Code 
Boundary

Space 
Required

DOS 6.22 and 
earlier

Primary FAT 2 GB 8 MB

Windows 95 Primary FAT or FAT32* 8 GB 90 MB

Windows 98 Primary FAT or FAT32 >8 GB 175 MB

Windows Me Primary FAT or FAT32 >8GB 295 MB

Windows NT Primary** FAT or NTFS 4 GB 125 MB

Windows 2000 Primary** FAT, FAT32, or 
NTFS

>8 GB 1 GB

Linux Either Linux Ext2 8 GB 250 MB

OS/2 Either FAT or HPFS 4 GB 110 MB

* A FAT32 partition is only accessible from Windows 95 if you have a version OSR2 
(4.00.950B) or above.

**Windows NT and Windows 2000 must boot from a primary partition (the system 
partition) on the first drive. However, only a few Windows NT/Windows 2000 files 
must reside on that partition; the remaining files can reside on a logical partition, which 
can be located on the first or a subsequent drive. The Windows NT/Windows 2000 
system partition can be shared with another operating system. Additionally, Windows 
NT must be installed on a FAT partition. Windows 2000 can be installed on a FAT, 
FAT32, or NTFS partition. During the installation, you can convert a FAT (or FAT32 if 
installing Windows 2000) partition to NTFS.



Chapter 7: Completing Disk Operations80

1,024 Cylinder Limit” and “Understanding the 2 GB Boot Code 
Boundary” in Help. The partition map in the VolumeManager main 
window displays indicators for the 2 GB boot boundary and the 1024 
cylinder (8 GB) limit.

VolumeManager displays a warning if you attempt to create, move, or resize a bootable 
partition outside of the 2 GB boot code boundary. If you continue with the operation, you 
may not be able to boot or to see the partition. In either case, you can resolve the problem 
by moving the partition back within the boot code boundary with the VolumeManager 
rescue disks.

Some I/O cards (typically older RAID cards) only provide access to the first 8 GB of a 
disk under DOS. Consequently, if you resize the operating system partition beyond 8 GB 
and it becomes unbootable, the VolumeManager rescue disks may not allow you to 
manipulate partitions on that drive. You should be cautious about resizing any operating 
system partition beyond 8 GB.

Deleting Partitions

The Delete operation deletes a partition and makes its data inaccessible. The Delete and 
Shred operation destroys the data in a selected partition by overwriting the disk sectors. 
Once a partition has been shredded, it cannot be undeleted.

1 Select the partition you want to delete.

To delete an extended partition, you must first delete all logical partitions within the 
extended partition. You cannot shred unallocated space.

If Remote Agent is running, you can delete a partition on a remote server.

2 Click Operations ➤ Delete.

The Delete Partition dialog appears.

3 Click Delete or Delete and Shred.
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Be aware that deleting and shredding a partition takes much longer than deleting a 
partition.

4 Click OK. 

Undeleting Partitions

The Undelete operation restores FAT, FAT32, and NTFS partitions that have been deleted 
on disk. Undelete works best when you use it to restore a partition that you just deleted by 
accident. If you are undeleting partitions after you have made other changes (written data 
to them, resized existing partitions, etc.), see “Restrictions on Undeleting Partitions” on 
page 82.

1 Select the unallocated space to be searched.

If Remote Agent is running, you can search unallocated space on a remote server.

2 Click Operations ➤ Undelete.

IMPORTANT! You can undelete a partition only if no other operations are pending on 
the unallocated space selected. If any operations are pending, the 
undelete icon and menu option will be dimmed (inaccessible).

The Undelete dialog appears, and the selected unallocated space is searched.

All primary and logical partitions that can be undeleted are listed. If no partitions are 
found within the unallocated space or none can be undeleted, a message appears 
indicating no partitions can be undeleted.

3 Within the scrollable list, click the checkbox of the partitions you wish to undelete.
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While it is possible to undelete more than one partition at once, PowerQuest 
recommends that you undelete partitions one at a time, beginning with the one that 
you want most. Doing so helps ensure the integrity of the data within the partition.

4 Click OK.

Restrictions on Undeleting Partitions

There are some situations in which a partition that has been deleted cannot be undeleted 
and will not be displayed in the scrollable list. They include the following:

• You cannot undelete a primary partition if your hard disk contains four primary 
partitions.

• You cannot undelete a logical partition that was deleted and now is not within an 
extended partition.

• You cannot undelete a primary partition that was deleted and now is within an 
extended partition.

• The partition includes file system errors. If VolumeManager finds a partition, it 
checks for errors before undeleting it. If the partition has errors, it cannot be 
undeleted.

• You cannot undelete a partition that has been completely or partially overwritten by 
another partition or file system. Because of this limitation, if you see two partitions in 
the Undelete dialog and undelete one of them, the other may no longer appear in the 
list.

• If two deleted partitions claim some of the same disk space, PowerQuest cannot 
guarantee the integrity of the data in those partitions when they are undeleted. For 
example, suppose you had two partitions, a 500 MB E: and a 500 MB F:, and you 
deleted F: and resized E: to claim all the space (1 GB). Then you saved data to E:. 
Later, you deleted E:. Now you want to undelete partitions, and you can see both E: 
and F: in the Undelete dialog. If you restore E:, it is fine and F: is no longer displayed 
in the dialog (because its space has been claimed). However, if you undelete F: 
instead of E:, you may get some data that you had saved to E:. Undeleting F: could 
make your computer unbootable or cause applications not to run.

Changing Partition Labels

The Label operation lets you change a partition’s label. Meaningful names make partition 
management easier.
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1 Select the partition with the label you want to change.

If Remote Agent is running, you can label partitions on a remote server.

2 Click Operations ➤ Label.

The Label Partition dialog appears.

3 In the New Label box, type the new label.

NTFS volume labels can contain up to 32 alphanumeric characters. FAT volume 
labels can contain up to 11 alphanumeric characters and cannot contain the following 
characters:* ? [ ] < > | + = : ; , . \ / ”.

4 Click OK.

Formatting Partitions

The Format operation formats a partition, destroying all its data in the process. Formatting 
enables you to put a different file system on a partition.

VolumeManager has several conversion options that let you convert from one file system 
to another without destroying existing files in a partition. See “Converting Partitions” on 
page 119.

1 Select the partition you want to format.

If Remote Agent is running, you can format partitions on a remote server.

2 Click Operations ➤ Format.
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The Format Partition dialog appears.

3 From the Partition Type drop-down list, select the desired file system type. 

If the partition is too small or too large, some partition types may not be available.

4 (Optional) Type a label for the partition. 

5 Click OK.

Copying Partitions

The Copy operation lets you to make an exact duplicate of a partition. To copy a partition, 
you must have unallocated space that is equal to or larger than the partition you are 
copying.

Reasons why you might want to copy a partition include:

• To duplicate your operating system before upgrading to a new version or a different 
operating system (so that you can remember how the old operating system’s 
windows, program icons, and properties were set up).

• To quickly move a smaller hard disk’s contents to a larger, new hard disk.

• To change the relative order of partitions.

• To back up a partition.

1 Select the partition you want to copy.

The Copy command is dimmed if there is not enough unallocated space on your disk 
for the partition.

If Remote Agent is running, you can copy partitions to or from a remote server.

You cannot use VolumeManager to copy Windows NT stripe sets, stripe sets with 
parity, or duplex/mirrored sets. 
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2 Click Operations ➤ Copy.

The Copy Partition dialog appears.

3 From the Disk drop-down list, select the disk where you want to copy the partition.

4 In the partition list, select the unallocated space where you want to copy the partition.

5 If the partition you specified is smaller than the available unallocated space, you can 
position the partition at the beginning (recommended) or end of the unallocated space. 
Under Position, click Beginning of free space or End of free space.

6 Click OK.

The copy is the same size (or slightly different if copied to a disk with a different 
geometry) and file system type and contains the same data as the original.

Copying the Boot Partition

If you copy the Windows NT boot partition to a different drive and Windows NT is booted 
to run from the new location, all the user-assigned drive letters will be dropped. When 
Windows NT boots, it compares current disk geometries to those stored in the registry for 
all user-assigned drive letters. When the stored values do not match a partition, the drive 
letter assignment is reset. Consequently, if Windows NT is booted from the copied 
partition, you could see error messages about services not starting. In Event Viewer, you 
may see Stop errors with event IDs 2511 and 7000.

To fix the problem, you must reassign the boot partition its original drive letter. You may 
need to reboot Windows NT more than once to completely reassign all drive letters to their 
original designations.
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Checking Partitions for Errors

The Check for Errors operation checks the integrity of a partition.

Each time VolumeManager is started, it performs a check on all attached drives and their 
partitions. If the check finds a problem, “Check failed” appears in the partition list window 
under the Type column. This check is separate from the Check for Errors operation and is 
not as exhaustive.

1 Select the partition you want to check.

VolumeManager can only check partitions that it can lock (that is, partitions that do 
not have open files on them). If there are open files on a partition, the Check for errors 
command on the menu will be dimmed.

If Remote Agent is running, you can check partitions on a remote server.

2 Click Operations ➤ Check for Errors.

The Check Partition Results dialog appears.

If Check for Errors does not discover any errors, an Info entry appears with “Check 
Complete” in the Description column. 

If a Check for Errors operation fails, “Check Failed” appears in the Used and Unused 
columns in the partition list. You should fix any errors encountered. For more 
information, see “Resolving Check Errors” on page 150.

If Check for Errors finds an error, such as cross-linked files, lost clusters, or bad 
directory information on an NTFS volume and can fix it, a Fix button appears at the 
bottom of the dialog. For each error found, VolumeManager displays the following:
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• Severity describes the seriousness of the problem, which can be one of the 
following:

• Fixed displays Yes for each problem you fix on an NTFS volume. Not applicable 
for FAT, FAT32, or HPFS partitions.

• Number shows a number corresponding to the error. For more information, see 
“Error Messages and Solutions” on page 154.

• Description gives a brief description of the problem.

3 To fix an error, highlight the problem and click Fix.

4 If you want to skip one listed error, click Skip.

If you want to skip all listed errors, click Skip All.

5 When you are finished viewing the check results and fixing NTFS errors, click Close.

Check for Errors does not display information about the status and structure of a partition 
as do the DOS, Windows, and OS/2 CHKDSK utilities. To view that information, use the 
Info operation. For details, see “Getting Information About Partitions” on page 91.

VolumeManager checks for OS/2 Extended Attribute errors on FAT partitions. If you do 
not use OS/2 or previously used OS/2 but no longer do, consider enabling the Ignore 
OS/2 EA Errors on FAT preference, as these errors are not a concern. For more 
information, see “Changing VolumeManager Preferences” on page 66. OS/2 users should 
not enable Ignore OS/2 Errors on FAT, as undetected errors could cause data loss.

Severity Description

Info The information given is helpful but not critical. Does not 
correspond to any error.

Warning The error may or may not cause problems.

Error A problem was encountered, but VolumeManager may still be 
able to make changes to the partition. Run CHKDSK to fix the 
error, or click Fix, if available.

Critical A catastrophic problem. VolumeManager cannot make any 
changes to the partition.
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Merging Partitions

You can merge two FAT or FAT32 partitions that are adjacent to each other on a disk. It is 
useful to merge partitions if you have reached the maximum number of partitions on your 
disk, but you do not want to delete a partition. It is also useful if you want to combine FAT 
partitions and convert them to one large FAT32 partition.

IMPORTANT! Merging partitions may take a long time (possibly hours), depending on 
the partition sizes and amount of data they contain. If you wish to check 
whether your machine is still operating, you can press the NumLock key 
and see if the light toggles. It may take a few seconds to register activation 
of the NumLock key on your keyboard. If you plan to merge partitions, 
you may wish to schedule it for a time when you will not need to use your 
system for an extended period of time. If you shut down or turn off your 
computer while VolumeManager is still working, it will cause 
corruption to the file system, which will result in data loss. Do not shut 
down the system until after the process is complete.

1 Select one of the two partitions you want to merge with another partition.

2 Click Operations ➤ Merge.

The Merge Adjacent Partitions dialog appears.
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3 Under Merge options, choose the partitions you would like to merge.

The contents of one partition will be moved into a folder within the other partition.

You should not merge partitions that contain different operating systems.

4 Under Merge Folder, type a name for the new folder that will be created in the 
partition you are keeping.

5 Choose FAT or FAT32 for the format of the partition you are keeping.

If you are combining FAT partitions, be careful not to convert them to FAT32 unless 
you have access to FAT32 partitions. Windows 95b or later, Windows 98, Windows 
Me and Windows 2000 can access FAT32 partitions.

6 Click OK.

The partition map in the main window changes to show the merged partitions.

Splitting Partitions

Use Split to divide a FAT or FAT32 partition into two contiguous partitions. The new 
partition is created to the right of the original partition; the original and new partitions 
together occupy the same amount of hard disk space as the original partition. The file 
system for the partition does not change. For example, if you had a 2 GB FAT partition and 
you split it, the left and right partitions together would use 2 GB and both would be FAT 
partitions.

When you split a partition, you can select the files and folders that you want the new 
partition to include. You can also label the new partition and specify whether it is primary 
or logical.

1 Select the partition you want to split.

You cannot split a partition that is smaller than 100 MB.

A FAT partition must have at least 5% unused space, or the Split command will be 
dimmed on the menu. A FAT32 partition requires 10% unused space to split.

PowerQuest does not recommend splitting your operating system partition.
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2 Click Operations ➤ Split.

3 Under Original Partition, select the files and folders you want to move to the new 
partition, then click the single right arrow.

Click the left arrow to remove selected files and folders from the new partition. To 
move all files and folders to the new partition, click the double right arrow. You can 
also click the left arrow to move selected files and folders back to the original 
partition if you change your mind. You must, however, have at least one file or folder 
remaining in each partition.

4 (Optional) Type a name for the new partition in the Label text box.

5 Select a partition type for the new partition from the Pri/Log drop-down list.

You cannot use the Split operation to convert the original partition from primary to 
logical or vice versa.

6 Click OK.

The size of the new partition is based on the minimum possible size and the total byte size 
of the files you are adding to the new partition. Any remaining free space is split 
proportionally between the two partitions according the data in the partitions. For 
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example, if the two partitions used 2 GB and you included 700 MB of data in the original 
(left) partition and 300 MB of data on the new (right) partition, you would have 1 GB of 
free space available; the original partition would get 700 MB of unused space, and the new 
partition would get 300 MB of unused space.

Both the original and new partitions must be at least 40 MB. On hard disks larger than 4 
GB, VolumeManager will round the size of the partition up to at least 47 MB.

Getting Information About Partitions

The Info operation displays information about the status and structure of a selected 
partition.

If you select a volume segment (in Disk view), the Info operation displays information 
about the selected volume segment, not the entire volume set. To display information 
about an entire volume set, see “Displaying Information About Volume Sets” on page 
109.

1 Select the partition you want information about.

If Remote Agent is running, you can get information about a partition on a remote 
server.

2 Click Operations ➤ Info.
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The Partition Information dialog appears.

Information is displayed in tabbed pages. To view a page, click its associated tab, 
which is always visible at the top of the pages. Based on the file system the partition 
uses, different pages appear.

3 Click the tab for the page you wish to view.

Each page is described in the following sections.

4 Click Close when you are finished viewing information.

Usage

The Usage page is available for the FAT, FAT32, NTFS, and HPFS file systems. This page 
displays the following information in bytes, megabytes, and as a percentage:

• Used space on the partition, including space wasted by clusters
• Unused space on the partition
• Bad space on the partition
• Total space on the partition (the sum of Used, Unused, and Bad space)

VolumeManager also displays this information in a pie chart.
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Cluster Waste

The Cluster Waste page applies only to partitions using the FAT or FAT32 file systems.

This page displays the following information:

• Current Cluster Size in bytes or kilobytes
• Data stored on the partition in bytes and megabytes
• Wasted space on the partition in bytes and megabytes
• Total used space in bytes and megabytes (the sum of Data and Wasted space)

VolumeManager also displays this information in a bar chart.

Partition Info

The Partition Info page is available for all types of partitions, including unallocated space 
and extended partitions. Information on this page includes the following:

• Partition type is shown in hexadecimal followed by a text description of the partition 
or file system type (such as FAT, FAT32, NTFS, or HPFS). The hexadecimal 
designation is the conventional way to display partition types.

• Serial Number is shown if the partition’s file system uses serial numbers.

The lower portion of the page shows physical information about the partition:

• First physical sector shows the logical number and the location (cylinder, head, and 
sector) where the partition begins.

• Last physical sector shows the logical number and the location (cylinder, head, and 
sector) where the partition ends.

• Total physical sectors displays the number of sectors in the partition.

• Physical Geometry shows the total number of cylinders, heads, and sectors on the 
physical disk where the partition resides.

File System-Specific Info Pages

The last page in the Partition Information dialog corresponds to the file system used on 
the selected partition. For example, if the file system is FAT or FAT32, the page is FAT 
Info; if the file system is NTFS, the page is NTFS Info, and so forth.

FAT Info

This page applies to partitions using the FAT or FAT32 file systems.
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The first section provides the following information:

• Sectors per FAT shows the number of sectors in each file allocation table and the 
number of file allocation tables on the selected partition.

• Root directory capacity shows the number of possible entries and the number of 
sectors in the root directory. Because a FAT32 root directory can grow as needed, this 
line is blank for FAT32 partitions.

• First FAT sector shows the logical sector number within the partition where the FAT 
begins.

• First Data sector shows the logical sector number within the partition where the data 
portion of the partition begins.

The next section provides the following information:

• The number of bytes in files on the partition, the number of files, and the number of 
those files that are hidden

• The number of bytes in directories on the partition, the number of directories, and the 
number of those directories that are hidden

The final section of this page, FAT Extensions, provides the following information: 

• The number of bytes used for OS/2 Extended Attributes and the number of files and 
directories affected by Extended Attributes

• The number of bytes used for long filenames and the number of files and directories 
using long filenames

NTFS Info

This page applies to partitions using the NTFS file system. The first section shows the 
following information:

• NTFS Version shows the version number. The NTFS version does not match the OS 
version. For example, Windows NT 4.0 uses NTFS version 1.3.

• Bytes per NTFS sector displays the number of bytes in each logical sector on the 
selected partition. (There are always 512 bytes in each physical sector.)

• Cluster size displays the size of each cluster and the number of sectors in each cluster 
on the selected partition.

• First MFT Cluster shows the logical number of the first cluster in the master file 
table (MFT).

• File Record Size gives the size of file records in the MFT.
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The next section displays information similar to that shown by NT CHKDSK:

• The number of files on the partition and the bytes and clusters allocated to them
• The number of wasted bytes in file clusters
• The number of indexes (directories) and the bytes and clusters allocated to them
• The number of bytes and clusters reserved for other system structures

HPFS Info

This page applies to partitions using the HPFS file system.

The first section displays the following information:

• Partition status shows one or more of these values:
• Active: OS/2 is running and data has been written to the partition.
• Dirty: Windows NT or OS/2 was shut down improperly and is not running. 
• Corrupt: One or more sectors are bad, and the partition needs to be checked. 
• Hot Fixes: Problems have been hot fixed.
• Not Active: The partition is not in use. 

• DirBlock sectors shows the range of sectors in the DirBlock band. The DirBlock 
band is usually preallocated near the center of the disk to reduce head movement.

• Free DirBlocks displays the number of unused DirBlocks in the DirBlock band and 
the total number of DirBlocks. If the DirBlock band fills up, additional DirBlocks are 
allocated from the data area. 

• HotFixes used displays the number of hotfix sectors used and the total number of 
hotfix sectors available. Hotfix sectors are used temporarily to handle write errors. 
CHKDSK /F transfers the data from a hotfix sector to a good sector and makes the 
hotfix sector available again. 

The last section displays information similar to that shown by OS/2 CHKDSK, including:

• The number of bytes and files on the partition and the number of sectors used for files

• The number of unused bytes in file sectors, which is equivalent to wasted bytes in 
FAT clusters. (Because HPFS allocates space by sectors, less space is wasted than in 
FAT clusters.)

• The number of bytes in directories, the number of directories on the partition, and the 
number of sectors used for directories

• The number of bytes in file/dir Fnodes, also shown as a number of sectors

An Fnode is a key structural element of the HPFS file system. Each Fnode is 512 
bytes (one sector). One Fnode exists for each file or directory in the partition.
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• Number of bytes reserved by the system, also shown as a number of sectors

• Number of bytes used for Extended Attributes (EAs)

Scanning a Disk for Errors

You can run the Windows NT CheckDisk utility (CHKDSK.EXE) from VolumeManager. 
Use CheckDisk to scan a disk or volume set for errors.

1 Select the disk or volume set you want to scan for errors.

2 Click Operations ➤ Windows CheckDisk.

CheckDisk only scans drives, partitions, and volumes with assigned drive letters; it 
does not scan unallocated space, and volumes and partitions with file systems not 
supported by Windows NT. (Windows NT supports FAT and NTFS. Windows 2000 
supports FAT, FAT32, and NTFS.)

VolumeManager invokes CheckDisk in read-only mode. In most instances, including 
the /F switch to fix errors on an NTFS partition requires a system reboot. If you want 
to fix discovered volume errors, you should exit VolumeManager and run CHKDSK 
/F from a command window. For more information about NT CheckDisk, consult 
Windows NT help.

3 When NT CheckDisk is finished, the results appear in the command window.

4 When you are finished viewing the results, press any key to close the command 
window.
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C H A P T E R8
Completing Advanced Disk 
Operations
This chapter includes the following information:

• Changing a Drive Letter

• Retesting Bad Sectors

• Hiding and Unhiding Partitions

• Resizing the Root Directory

• Setting an Active Partition

• Resizing Clusters
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Changing a Drive Letter

The Change Drive Letter operation lets you change the drive letter assigned to any 
partition visible to and supported by Windows NT.

IMPORTANT! Do not change the drive letter of your Windows NT or Windows 2000 boot 
partition to anything other than its original designation. Doing so will 
cause some services to fail upon reboot and may render your server 
unbootable.

1 Select the partition whose drive letter you want to change.

2 Click Operations ➤ Advanced ➤ Change Drive Letter.

The Change Drive Letter dialog appears. 

3 In the New drive letter box, type or select the drive letter you want to assign to the 
partition.

4 Click OK.

Retesting Bad Sectors

The Bad Sector Retest operation lets you check sectors on FAT and FAT32 partitions that 
have been marked bad and recover sectors that are usable.

The FAT and FAT32 file systems allocate disk space for file storage in units called 
clusters, which are composed of a fixed number of sectors. Because the FAT or FAT32 file 
system tracks bad sectors at the cluster level, it marks an entire cluster bad even though the 
problem may exist in a single sector. Use Info to discover whether a partition contains bad 
clusters. For more information, see “Getting Information About Partitions” on page 91.

As a conservative measure, when you move or resize a partition or increase cluster size, 
VolumeManager marks all new clusters containing any part of old bad clusters as bad 
(even though the clusters may not actually contain bad sectors). Likewise, when you 
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decrease a partition’s cluster size, VolumeManager divides bad clusters into multiple bad 
clusters. If, after you complete these tasks, VolumeManager reports bad sectors, you can 
perform Bad Sector Retest and reclaim the good sectors that were marked bad.

1 Select the partition you want to retest.

2 Click Operations  ➤ Advanced  ➤ Bad Sector Retest.

The Bad Sector Retest dialog appears.

3 To continue with the test, click OK.

Some sectors marked as bad are “marginally bad,” meaning that one time the sector 
works fine and another time it does not. Bad Sector Retest may mark a marginally bad 
sector as good. This can result in data loss if the marginally bad sector fails in the 
future. Most modern hard drives detect bad sectors and automatically remap the 
sector, so in general, you do not see bad sectors on modern hard drives. If you do get 
bad sector errors on a modern hard drive, it is recommended that you replace the 
drive.

Hiding and Unhiding Partitions

The Hide Partition operation lets you secure partitions against unwanted user access. You 
can perform this operation on FAT, FAT32, NTFS, and HPFS partitions. 

When you hide a partition, it will not be assigned a drive letter the next time you boot your 
computer.

1 Select the partition you wish to hide.

If Remote Agent is running, you can hide or unhide a partition on a remote server.

2 Click Operations ➤ Advanced ➤ Hide Partition (or Unhide Partition).
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Note that unless you are running Windows NT or Windows 2000, unhiding multiple 
primary partitions may cause data loss.

The Hide Partition dialog appears, warning you that drive letters may change.

3 To confirm that you want to hide the partition, click OK.

Under Windows NT, partitions are not hidden automatically; therefore, you can have 
multiple visible primary partitions. 

Resizing the Root Directory

The Resize Root operation lets you change the maximum number of entries that can be 
placed in the root directory of a FAT partition. The number of root entries is set at the time 
the partition is formatted; the limit does not expand automatically as it does in a 
subdirectory or in a FAT32 partition. Consider increasing this number if you use Microsoft 
long filenames in the root directory. During this operation, data within the partition is 
unaffected.

1 Select the partition whose root directory you wish to resize.

2 Click Operations ➤ Advanced ➤ Resize Root.
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The Resize Root dialog appears, displaying the number of used entries and the 
current capacity.

3 In the New capacity box, type or select the number of entries you want the root 
directory to have.

The number you type will be rounded to one that preserves the current cluster 
alignment.

4 Click OK.

Occasionally, enlarging the root directory displaces the first few files on the partition (such 
as IO.SYS and MSDOS.SYS if the partition contains an operating system). If the root 
directory is on a boot partition and the partition fails to boot after resizing the root 
directory, you should run SYS.COM to move the displaced files back to the front of the 
disk.

Setting an Active Partition

The Set Active operation lets you make a partition the active partition (the partition the 
computer boots from). Only one partition can be active at a time. To boot your computer 
from a partition, the partition must be on the first disk, and it must contain an operating 
system. When your computer boots, it reads the partition table of the first disk to find out 
which partition is active and boots from that partition.

IMPORTANT! Before you make a partition active, it must be bootable. If the partition is 
not bootable or if you are not certain if it is, have a boot diskette ready.

VolumeManager hides inactive FAT, NTFS, and HPFS primary partitions (unlike 
Windows 9x and DOS FDISK programs which cannot hide or unhide partitions). Hiding 
inactive primary partitions makes it easy to install multiple operating systems and choose 
the one you want to set active. For example, if you have Windows 95 and want to install 
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Windows NT in a separate partition, you can make the Windows 95 partition smaller, 
create another primary partition, set it as the active partition, and then boot from the 
Windows NT installation diskettes.

1 Select the partition you want to make active.

2 Click Operations ➤ Advanced ➤ Set Active on the context menu.

In a configuration with mixed IDE and SCSI hard disks, Windows NT does not 
always see the boot drive as the first disk. VolumeManager displays drives in the 
order that Windows NT reports them. As a result, you may see your boot device as 
drive 1, 2, etc. VolumeManager may also incorrectly report that there is no active 
partition. Be sure you identify which drive is the boot drive.

The Set Active Partition dialog appears.

3 Click OK.

Resizing Clusters

The Resize Clusters operation lets you change the cluster size on FAT and FAT32 
partitions. Reducing cluster size may help you reclaim wasted space on your hard disk.

All files on FAT and FAT32 partitions are stored in allocation units called clusters. Each 
file on a partition is allotted at least one cluster. The size of a partition determines cluster 
size. Unless the size of a file is an exact multiple of cluster size on the partition where the 
file is located, the file includes wasted space. Larger partitions have larger clusters, and, 
therefore, more wasted space. For more information, see “Making Efficient Use of Disk 
Space” in Help.

1 Select the partition where you want to resize clusters.

2 Click Operations ➤ Advanced ➤ Resize Clusters.
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The Resize Clusters dialog appears.

For each cluster size, VolumeManager displays the following:

• A bar graph and percentages represent how much space would be used and how 
much space would be wasted if you chose that cluster size for the currently 
selected partition

• Wasted space (in megabytes)

• The range of allowable partition sizes (in megabytes) or other information

• If a cluster size requires a partition that is too small for the data and files on the 
partition, “Not Available” appears in the Notes column. “Not Enabled” appears in 
the Notes column for the 64 K cluster size because it is only used for Windows 
NT/2000. You can enable the 64 K cluster size, but it is not recommended. For 
more information, see “Allow 64K FAT Clusters for Windows NT/Windows 
2000” on page 66.

The lower portion of the Resize Clusters dialog displays information about the 
current and new cluster size and the current and new partition size (based on the new 
cluster size).

3 Using the information in the dialog, decide which cluster size you want to use (and 
can use) and select it from the New cluster size drop-down list.

VolumeManager adheres to the established limits for partition and cluster sizes. You 
cannot select a cluster size that is invalid for the selected partition.
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It is not recommended that you use the smallest cluster size on partitions containing a 
single, large file, such as a database or swap file.

Choosing a smaller cluster size may resize the partition smaller, creating unallocated 
space next to the partition. You can use this unallocated space by creating a new 
partition.

4 Click OK.

Default Cluster Sizes

A partition’s cluster size is set by the DOS FORMAT operation, based on the size of the 
partition, as shown in the following tables.

DOS and Windows default FAT cluster sizes

Partition Size (MB) FAT Type Sectors Per Cluster Cluster Size

0-15 12-bit 8 512 bytes

16-127 16-bit 4 2 K

128-255 16-bit 8 4 K

256-511 16-bit 16 8 K

512-1,023 16-bit 32 16 K

1,024-2,047 16-bit 64 32 K

2,048-4,096 16-bit 128 64 K*

*Only available with Windows NT and Windows 2000 and a 2-4 GB disk.

Windows 95 OEM Service Release 2, Windows 98, Windows 
Me, and Windows 2000 default FAT32 cluster sizes

Partition Size (GB) Sectors Per Cluster Cluster Size

0.256- 8.01 8 4 K

8.02-16.02 16 8 K

16.03-32.04 32 16 K

> 32.04 64 32 K
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C H A P T E R9
Managing Volume Sets
This chapter includes the following information:

• Copying Volume Sets

• Resizing Volume Sets

• Formatting Volume Sets

• Changing Volume Set Labels

• Displaying Information About Volume Sets

• Deleting Volume Sets

• Checking Volume Sets

• Moving Volume Segments

IMPORTANT! Before you perform any operations in VolumeManager, you 
should be familiar with the material explained in 
“VolumeManager Basics,” which begins on page 49. All but one 
of the operations in this chapter require that you select a volume 
from the Volume Sets window in VolumeManager. The Move 
Segment operation is available from the Disks window.
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Copying Volume Sets

The Copy and Consolidate operation copies all the data from a volume set and 
consolidates it to an unallocated space you specify. This procedure creates a new partition 
which can be accessed from the Disks window (not the Volume Sets window).

You can use the Copy and Consolidate operation to upgrade a FAT volume set by 
consolidating it into a FAT partition and then converting that partition to NTFS.

IMPORTANT! To copy and consolidate a volume set, you must have unallocated space 
that is equal to or larger than the volume set.

1 Select the volume set you want to copy.

If Remote Agent is running, you can copy and consolidate volume sets to a remote 
server.

2  Click Operations ➤ Copy and Consolidate.

The Copy and Consolidate Volume Set dialog appears.

3 From the Disk drop-down list, select the disk where you want to copy and consolidate 
the volume set. 

The type and size of the space available is reflected in the partition map and partition 
list. The disk you select must have a sufficient amount of unallocated space. 
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4 In the Position box, click Beginning of unallocated space or End of unallocated 
space.

5 Click OK to add the operation to the VolumeManager queue.

VolumeManager changes the view from the Volume Sets window to the Disks 
window so that you can view the resulting partition.

Resizing Volume Sets

The Resize operation lets you change the size of a volume set by resizing the last segment 
within the set. If you are decreasing the size of the volume, data is shifted from the last 
segment to other segments in the volume set as needed. If you are increasing the size of the 
volume, the last segment is expanded.

1 Select the volume set you want to resize.

IMPORTANT! You cannot resize FAT16 volume sets.

2 Click Operations ➤ Resize.

The Resize Volume Set dialog appears.

The current size of the volume set is shown on the volume set map at the top of the 
dialog. The minimum and maximum sizes to which you can resize the volume set also 
appear in the dialog.

3  Place the pointer on the volume set handle (the right edge) and drag the handle to the 
left or right until you reach  the desired size. 
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The pointer changes to a double-headed arrow when it is positioned over the handle.

You can also resize the volume set by typing new values in the New Size, and Free 
Space After boxes or by clicking the arrows next to the boxes. The arrow buttons 
resize the set by the minimum increment, allowing you to make fine adjustments. 
Changes are reflected in the volume set map.

When you enlarge a set, there must be free space adjacent to it. If, for example, there 
is a  partition next to the last volume segment, you cannot resize larger, only smaller. 

When you reduce the size of a set, VolumeManager shifts the data from the last 
segment to one or more other segments in the volume set. The size to which you can 
reduce a volume set is the greater of either the amount of data in the volume set or the 
sum total of all the segments minus the size of the last segment plus one cylinder. 

4 Click OK.

Formatting Volume Sets

The Format operation formats a volume set, destroying all its data in the process. 
Formatting lets you  put a different file system on a volume set.

1 Select the volume set you want to format.

2 Click Operations ➤ Format.

The Format Volume Set dialog appears.

3 From the Volume Set Type drop-down list, select the desired file system type.

You can only choose between FAT or NTFS. FAT is unavailable if the volume set is 
greater than 2 GB (or 4 GB if 64K clusters are enabled in preferences).

4 (Optional) Type a label for the volume.



PowerQuest VolumeManager 109

Changing Volume Set Labels

Use the Label operation to change a volume set label. Giving your volumes meaningful 
names makes managing them easier.

1 Click Volume Sets to display the Volume Sets window.

2 From the volume map, list, or tree view, select the volume set you want to label.

3 Click Operations ➤ Label.

The Label Volume Set dialog appears.

4 In the New Label box, type the new label.

NTFS volume labels can contain up to 32 alphanumeric characters. FAT volume 
labels can contain up to 11 alphanumeric characters and cannot contain the following 
characters:* ? [ ] < > | + = : ; , . \ / ”.

5 Click OK.

Displaying Information About Volume Sets

The Info operation displays information about the status of a selected volume set.

1 Click Volume Sets to display the Volume Sets window.

2 From the volume map, list, or tree view, select the volume set on which you want 
information.

3 Click Operations ➤ Info.

The Volume Set Information dialog appears.
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Information is displayed in tabbed pages. To view a page, click its associated tab, 
which is always visible at the top of the page. Based on the file system the volume set 
uses, different pages appear.

4 Click the tab for the page you want to view.

Each page is described in the following sections

5 Click Close when you are finished viewing information.

Usage

The Usage page displays the following information in bytes, megabytes, and as a 
percentage:

• Used space in the volume set, including space wasted by clusters.

• Unused space in the volume set.

• Bad space in the volume set.

• Total space in the volume set (the sum of Used, Unused, and Bad space)

VolumeManager also displays this information in a pie chart.
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FAT Info

The page applies to volume sets using the FAT16 file systems.

The first section provides the following information:

• Sectors per FAT shows the number of sectors in each file allocation table and the 
number of file allocation tables in the volume set.

• Root directory capacity shows the number of possible entries and the number of 
sectors in the root directory. 

• First FAT sector shows the logical sector number within the volume set where the 
FAT begins.

• First Data sector shows the logical sector number within the volume set where the 
portion of the volume begins.

The next section provides the following information:

• The number of bytes in files in the volume set, the number of files, and the number of 
those files that are hidden.

• The number of bytes in directories in the volume set, the number of directories, and 
the number of those directories that are hidden.

The final section of this page FAT Extensions, provides the following information.

• The number of bytes used for long filenames and the number of files and directories 
using long filenames.
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NTFS Info

This page applies to volume sets using the NTFS file system.

• NTFS Version shows the version number as reported by the file system. Note that the 
file system version is not the same as the operating system version.

• Bytes per NTFS sector displays the number of bytes in each logical sector on the 
selected volume set. (There are always 512 bytes in each physical sector.)

• Cluster size displays the size of each cluster and the number of sectors in each cluster 
on the selected partition.

• First MFT Cluster shows the logical number of the first cluster in the master file 
table (MFT).

• File Record Size gives the size of the file records in the MFT.

The next section displays information similar to that shown by NT CheckDisk:

• The number of files in the volume set and the bytes and clusters allocated to them
• The number of wasted bytes in file clusters
• The number of indexes (directories) and the bytes and clusters allocated to them
• The number of bytes and clusters reserved for other system structures
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Deleting Volume Sets

The Delete operation deletes a volume set and makes its data inaccessible. The Delete and 
Shred operation destroys the data on a volume set by overwriting the disk sectors occupied 
by the volume set. 

You cannot delete a volume segment, only a volume set. Additionally, you cannot undelete 
a volume set.

1 Select the volume set you want to delete.

2 Click Operations ➤ Delete.

The Delete Volume Set dialog appears.

3 Click Delete or Delete and Shred.

4 Click OK.

Checking Volume Sets

The Check for Errors operation checks the integrity of a volume set.

1 Click Operations ➤ Check for Errors.

VolumeManager can only check volumes that it can lock (that is volumes that have 
no open files on them). Consequently, sometimes the Check for Errors option is 
disabled.
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The Check Volume Set for Errors dialog appears.

If VolumeManager does not discover any errors, an Info entry appears with “Check 
Complete” in the Description column.

If a Check operation fails, “Check Failed” appears in the Used and Unused columns 
in the partition list. You should fix any errors encountered. For more information, see 
“Resolving Check Errors” on page 150.

If Check for Errors finds an error (such as cross-linked files, lost clusters, or bad 
directory information on an NTFS volume) and can fix it, the Fix button is enabled at 
the bottom of the dialog.

For each error found, Check for Errors displays the following:

• Severity describes the seriousness of the problem, which can be one of the following:

• Fixed displays Yes for each problem you fix on an NTFS volume. 

Info The information given is helpful but not critical. Does not correspond 
to any error.

Warning The error may or may not cause problems.

Error A problem was encountered, but VolumeManager may still be able to 
make changes to the volume set. If available, click Fix to fix the error. 
If VolumeManager is unable to fix the error, run CHKDSK /F from 
the command prompt.

Critical A catastrophic problem. VolumeManager cannot make any changes 
to the partition.
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• Number shows a number corresponding to the error. For more information about 
error messages, see “Error Messages and Solutions” on page 154.

• Description gives a brief description of the problem.

2 To fix an error on an NTFS volume, select the problem and click Fix.

3 If you want to skip one listed error, click Skip. If you want to skip all listed errors, 
click Skip All.

4 When you are finished viewing the check results and fixing NTFS errors, click Close.

Check for Errors does not display information about the status and structure of a volume 
as does DOS, Windows, and OS/2 CHKDSK utilities. To view that information, use the 
Info option.

VolumeManager checks for OS/2 Extended Attribute errors on FAT partitions. If you do 
not use OS/2 or previously used OS/2 but no longer do, consider enabling the Ignore OS/2 
EA Errors on FAT preference, as these errors are not a concern. See “Integrity Checks” 
on page 72.

Each time VolumeManager is started, it performs a check on all attached drives and their 
partitions. If the check finds a problem, “Check Failed” appears in the partition list 
window under the Type column. This check is separate from the Check for Errors 
operation and is not as exhaustive.

Moving Volume Segments

The Move Segment operation lets you move a volume set segment (not a volume set) to 
the left, right, or a new location. Note that this operation is available from the Disks 
window, not the Volume Sets window.

Left or Right

You can move a volume segment to a new location by selecting the segment from the tree 
view or partition map then dragging and dropping it to adjacent unallocated space on the 
same hard disk.

1 Click Disks to display the Disks window.

This operation is available from the Disks Window, not the Volume Sets window.

2 Select the volume segment you want to move.
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3 Click Operations ➤ Move Segment ➤ Left/ Right.

The Move Segment Left/Right dialog appears. The current size of the volume 
segment is shown on the volume segment map at the top of the dialog.

4 To move a volume segment, place the pointer on the segment and drag it to the desired 
location.

The hard disk must have free space adjacent to the segment.

The pointer changes when it is located over a segment.

You can also move the segment by typing new values in the Free Space Before, and 
Free Space After, boxes or by clicking the arrows next to the boxes. The arrow button 
moves the segment by the minimum increment, allowing you to make fine 
adjustments. Changes are reflected in the volume segment map.

5 Click OK.

New Location

1 Click Disks to display the Disks window.

2 Select the volume segment you want to move.

3 Click Operations ➤ Move Segment ➤ New Location.
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The Move Segment to New Location dialog appears.

4 From the Disk drop-down list, select the disk where you want to move the volume 
segment.

The type and size of the space available is reflected in the partition map and partition 
list. The disk you select must have a sufficient amount of unallocated space.

5 In the Position box, click Beginning of unallocated space or End of unallocated 
space.

6 Click OK.
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C H A P T E R10
Converting Partitions
This chapter includes the following information:

• Procedure for Converting Partitions

• Converting FAT Partitions to FAT32

• Converting FAT Partitions to HPFS

• Converting FAT Partitions to NTFS

• Converting FAT32 Partitions to FAT

• Converting FAT32 to NTFS

• Converting NTFS Partitions to FAT or FAT32

• Converting Partitions to Logical or Primary
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Procedure for Converting Partitions

You can convert the following file formats:

• FAT partitions to FAT32
• FAT partitions to HPFS
• FAT partitions to NTFS (Windows NT/2000 only)
• FAT32 partitions to FAT
• FAT32 partitions to NTFS (Windows 2000 only)
• NTFS partitions to FAT
• NTFS partitions to FAT32

You can also convert primary partitions to logical and logical partitions to primary.

You cannot convert FAT or FAT32 partitions to NTFS if you are running VolumeManager 
from the rescue disks.

You should not convert file system types on compressed drives. First, uncompress the 
drive, then run the conversion.

The basic conversion steps (1-4) are found below. However, for each file type there is 
specific information you need to know before beginning any conversion. Please see the 
appropriate heading listed in this section before completing the conversion procedure.

1 Select the partition you want to convert.

2 Click Operations ➤ Convert.

The Convert Partition dialog appears.

3 Under Convert to, choose the file system to which you want to convert the partition.
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Depending on the file format of the partition you are converting, some options may 
appear dimmed.

 If you want to convert your partition to primary or logical, see “Converting Partitions 
to Logical or Primary” on page 127. 

4 Click OK.

Converting FAT Partitions to FAT32

FAT32 partitions have less wasted disk space than FAT partitions. (For more information, 
see “Resizing Clusters” on page 102.) However, you should be aware of these issues:

• You must have Windows 95 OEM Service Release 2, or Windows 98/Me/2000 to 
access files on a FAT32 partition. If you run an operating system other than these, 
FAT32 partitions will be inaccessible when the other operating system is running, 
even if one of these operating systems is installed on your machine.

• The minimum recommended size for a FAT32 partition is 256 MB.

The steps for this process are listed on page 120.

Converting FAT Partitions to HPFS

During this operation, VolumeManager preserves data, long filenames (created by 
Microsoft Windows NT/95/98/Me), and Workplace shell long name Extended Attributes. 

WARNING! You must have OS/2 to access files on an HPFS partition. Without it, you 
will lose all files on the converted partition. Proceed with caution when 
performing this conversion, as it cannot be reversed.

1 Before you convert, back up the data on your boot drive.

Because the conversion cannot be reversed, we strongly recommend that you take this 
precautionary step. 

If a Corrective Service Facility (CSF) has been applied to your version of OS/2, you 
must make new Install/Utility diskettes and use them in place of your original OS/2 
diskettes. 

2 Reboot your system from a diskette, from a partition other than the one you are 
converting, or from DOS. 
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3 Run VolumeManager from a partition other than the one you are converting.

4 Follow the conversion steps listed on page 120.

5 If you have open files, a prompt appears indicating that the changes you have made 
require rebooting. Click OK to make the changes. After the changes are made, the 
computer is rebooted.

If you do not have any open files, the Batch Progress dialog appears. When all 
operations are complete, click OK to return to the VolumeManager main window. 

IMPORTANT! Complete the remaining steps only if the partition you converted to 
HPFS contains OS/2.

6 Copy SYSINSTX.COM from the OS/2 Installation Disk to the root of the new HPFS 
partition. 

7 Copy UHPFS.DLL from the OS/2 Disk 2 to the root of the new HPFS partition.

If you have an OS/2 CD-ROM, consult your IBM documentation for instructions on 
creating a diskette from the disk image. 

8 Change to the new HPFS partition by typing drive: (where drive is the drive 
letter of the partition you converted from FAT to HPFS). 

9 From the root of the new HPFS partition, type SYSINSTX drive: (where drive 
is the drive letter of the partition you converted from FAT to HPFS). 

10 Verify that HPFS.IFS is listed in the CONFIG.SYS file similar to the following: 

IFS=C:\OS2\HPFS.IFS /CACHE:256 /CRECL:4 /AUTOCHECK:C 

If this line is not present, add it, replacing C: and :C with the drive letter of the 
partition you just converted. 

IMPORTANT! If you want to be able to boot to the command line using <Alt+F1>, 
make this change to all CONFIG.* files in \OS2\BOOT. 

11 Verify that HPFS.IFS is present in the OS2 directory. If not, copy it from OS/2 
Installation Disk 1.

Your HPFS partition is now bootable.
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Converting FAT Partitions to NTFS

The Convert FAT to NTFS operation launches the Microsoft Convert utility to convert a 
FAT partition to NTFS. You must be running Windows NT/2000 to complete this 
conversion. This cannot be performed from the rescue diskette.

If you boot multiple OSs, you must be careful converting FAT to NTFS. NTFS is only 
accessible from Windows NT or Windows 2000; therefore, the data in this partition will 
not be accessible if you boot DOS or Windows 95/98/Me.

After clicking OK, if you have no operations pending and if Windows NT/2000 can lock 
the partition (no open files), the FAT partition is converted. If you have operations 
pending, you must apply them first before converting from FAT to NTFS. If you do not 
apply the operations, a prompt appears asking if you want to apply the changes now before 
converting your FAT partition. Click OK to apply the changes and continue with the 
conversion.

If you have any open files a message appears indicating that the convert utility cannot gain 
exclusive access to the drive and asks if you want to schedule the conversion the next time 
the system restarts. If you type Y, the conversion takes place automatically the next time 
you reboot your computer. It is recommended that after typing Y, you close 
VolumeManager and manually reboot to convert the partition.

Converting FAT32 Partitions to FAT

To complete this conversion, the partition must have at least 300-400 MB of unused space 
because of how the FAT file system allocates disk space for file storage.

If the FAT menu option is dimmed, your FAT32 partition contains over 2 GB of data. If the 
partition size is over 2 GB but it contains less than 2 GB of data, you can convert the 
partition (without data loss), but the new partition will be 2039 MB.

During the conversion, VolumeManager may report too many root directory entries (the 
maximum number of entries in a FAT partition’s root directory is limited, unlike a FAT32 
partition’s root directory). In this case, move or copy some of the files in the root directory 
to another location and then start the conversion again.



Chapter 10: Converting Partitions124

Converting FAT32 to NTFS

The Convert FAT32 to NTFS operation launches the Microsoft Convert utility to convert a 
FAT32 partition to NTFS. You must be running Windows 2000 to complete this 
conversion.

Be aware that data in an NTFS partition will not be accessible if you boot DOS or 
Windows 95/98/Me.

The steps for this process are listed on page 120.

After clicking OK, if you have no operations pending and if Windows 2000 can lock the 
partition (no open files), the FAT32 partition is converted. If you have operations pending, 
you must apply them first before converting from FAT32 to NTFS. If you do not apply the 
operations, a prompt appears asking if you want to apply the changes now before 
converting your FAT partition. Click OK to apply the changes and continue with the 
conversion.

If you have any open files a message appears indicating that the convert utility cannot gain 
exclusive access to the drive and asks if you want to schedule the conversion the next time 
the system restarts. If you type Y, the conversion takes place automatically the next time 
you reboot your computer. It is recommended that after typing Y, you close 
VolumeManager and manually reboot to convert the partition.

Converting NTFS Partitions to FAT or FAT32

Converting an NTFS partition to FAT allows you to view the contents of the partition from 
DOS, Windows 9x, or Windows Me, as well as Windows NT and Windows 2000.

Converting an NTFS partition to FAT32 allows you to view the contents of the partition 
from Windows 95b/98/Me/2000. However, a FAT32 partition will not be accessible to 
Windows NT.

IMPORTANT! Although converting a Windows NT or Windows 2000 boot partition from 
NTFS to FAT/FAT32 is possible, PowerQuest does not recommend it. 
Because of non-convertible security settings between NTFS and FATx, 
converting the boot partition may result in the server booting with only a 
few errors, or failing to boot altogether.

IMPORTANT! You will lose file system-specific information when converting from 
NTFS to FAT. Refer to “NTFS Information Lost When Converting to FAT 
or FAT32” on page 125 for additional information.
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If the conversion fails when you apply changes, refer to the bulleted list on page 125 for a 
list of possible reasons.

Restrictions on Converting NTFS Partitions to FAT or FAT32

NTFS is an advanced file system that supports many features unavailable in FAT or 
FAT32. Depending on the NTFS features used on the partition, the type of data, and 
partition size, you may or may not be allowed to complete the conversion.

If you receive an error message and the conversion stops, it is usually caused by one or 
more of the following:

• The file system for conversion is not allowed for the current partition size. A FAT32 
partition should be greater than 256 MB, and a FAT partition must be less than 2 GB.

• The NTFS partition has data in memory that has not yet been written to the hard disk.

• The file system has errors, such as lost clusters and cross-linked files. You can fix 
these problems, then try the conversion again.

• There is not enough temporary space in the partition to do the conversion. The 
conversion will require the NTFS system and the FAT32 system files until the last 
step of the conversion. Also, there is data in NTFS File Replication Services that must 
be moved to external clusters and saved.

NTFS Information Lost When Converting to FAT or FAT32

If you can complete the conversion from NTFS to FAT or FAT32, you may receive a 
warning about the quality of data and feature loss, depending on the features used on the 
partition, the type of data, and the partition size.

Warning Description

Error The conversion is not allowed. Because the partition being converted 
is using advanced features in NTFS, you could experience unintended 
data and feature loss. You will receive an error in one or more of the 
following cases:

• There is more than one data stream for any file.
• Any links.
• Any extended attributes.
• Any user-defined attributes in any file.
• Device entries.
• There are sparse files on the volume. Any sparse files, except for 

the bad sector file, will stop the conversion.
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Warning The conversion is allowed. Although a conversion warning is not as 
serious as an error, you may still experience the loss of NTFS-specific 
features that are not supported in FAT32. You will receive a 
conversion warning in one or more of the following cases:

• Disk usage quotas - NTFS supports limiting the amount of disk 
space for a user. After conversion, all users will have full access 
to all free hard disk space.

• Access control lists - This is a file attribute that lists all the users 
that can access a file. After conversion, all users will have full 
access to all files.

• Index of access control lists - A list of all files that have specific 
access rights assigned to them. After conversion, all users will 
have full access to all files.

• FAST index file - This file is sometimes created on Windows 
2000 computers. After conversion, all indexing of keywords will 
be lost.

• Old versions of files - NTFS has the ability to keep versions of 
files, however, only the current version of the file is converted 
and saved.

No Warning The conversion is allowed. The most basic NTFS partition still gives 
files more features than are found in FAT or FAT32. When Windows 
NT 4.0 is used to copy files from an NTFS partition to a FAT 
partition, no warning is given about the features you are losing. Also, 
the conversion will not give you a warning about specific features that 
cannot be converted. These features include:

• Standard journal file (only used internally by NTFS) - This file is 
a transaction log of changes to the NTFS file system. After 
conversion, the journal file will be lost.

Warning Description
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Converting Partitions to Logical or Primary

You might want to convert a primary partition to a logical partition if you have reached the 
limit of primary partitions on your hard disk. If you create a logical partition, 
VolumeManager will automatically place it in an extended partition. You can then create 
more logical partitions within that extended partition, expanding the maximum number of 
partitions on the disk.

You might want to convert a logical partition to a primary partition if you plan to install an 
operating system on it. The partition must be a primary partition to be bootable.

IMPORTANT! If you convert a primary active partition to logical (such as your Windows 
NT/2000 system partition), your computer will not boot from the hard 
drive.

1 On the partition map, list, or tree view, select the partition you want to convert.

2 On the toolbar Operations ➤ Convert.

• NTFS-specific file attributes - NTFS and FAT both have 
standard file attributes, such as Read-only, Archive, Hidden, and 
System. NTFS has additional file attributes that can be set. After 
conversion, however, these additional file attributes will be lost.

• NTFS-specific file dates - The last edit date is converted to the 
FAT date. After conversion, the creation date, last access date, 
and last edit date (date change only) will be lost.

• Reliable change journal - This journal file is new to Windows 
2000. After conversion, this file will be lost.

Warning Description
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The Convert Partition dialog appears.

3 Click either Primary or Logical.

4 Click OK.

You cannot convert from primary to logical if another primary partition exists between the 
chosen partition and an existing logical partition.

You cannot convert from logical to primary if the conversion would result in more than 
four primary partitions or if the selected partition has one or more logical partitions to the 
left. For example, if you had a primary partition C: and logical partitions D:, E:, and F:, 
you could convert D: to primary, but you could not convert E: or F:.
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C H A P T E R11
Automating Tasks
This chapter includes the following information:

• Wizard Overview

Running Wizards

Applying Changes

Create New Partition Wizard

Resize Partitions Wizard

Redistribute Free Space Wizard

Merge Partitions Wizard

Copy Partition Wizard

Hiding Wizard Icons

• Scripting
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Wizard Overview

VolumeManager includes five wizards for common tasks. The wizards provide an 
alternative to performing the tasks manually using the commands on the Operations 
menu.

Running Wizards

There are two ways to run a wizard:

• Click Wizards on the menu bar, then click the wizard you want to run.
• Click the appropriate wizard icon in the VolumeManager main window.

Applying Changes

When you complete a wizard, the partition map and partition list in the main window 
reflect the changes you entered. However, the changes do not actually affect your system 
until you apply them.

You can apply (or discard) changes that you enter using wizards in three ways:

• Click  on the toolbar to apply the changes, or click  on the toolbar to undo 
the changes and start over.

• Click General ➤ Apply Changes (or Discard All Changes or Undo Last Change).

• Click the Apply Changes or Undo Last icon at the bottom of the main window.

After running a wizard, you can run other wizards or perform other partition operations 
and then apply or discard all the pending changes at once.

Create New Partition Wizard

The Create new partition wizard creates a new primary or logical partition.

You should be aware of the following considerations when creating a new partition:

• The file system you choose for the new partition will affect which operating systems 
can access the partition. The wizard dialogs will instruct you about the choices you 
make. For example, if you choose to create a FAT32 partition, the wizard will inform 
you that FAT32 partitions are used by Windows 95 OEM Service Release 2, and 
Windows 98/Me/2000 but that Windows 3.x, Windows NT, and DOS cannot access 
them. Pay close attention to the information in the dialog boxes, or you may 
inadvertently make your data inaccessible.
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• Before installing Windows NT, make sure that all the partitions that you want 
Windows NT to recognize end prior to cylinder 1024. Otherwise, Windows NT will 
not install and will report that all the partitions are corrupted. If you cannot resize and 
move all partitions, you must obtain updated drivers from Microsoft before installing 
Windows NT.

• After you apply the changes, your computer may reboot if the wizard resized any 
existing partitions. Also, on recognized partition types, the wizard will make the drive 
letter assignments, not the operating system.

Resize Partitions Wizard

The Resize Partitions wizard helps you resize a partition and lets you specify how the 
resize will affect other partitions on the same disk. For example, if you have C: and D: 
partitions and you choose to enlarge C:, the wizard could take space from D: and allocate 
it to C:.

For information about resizing partitions without the wizard, see “Resizing and Moving 
Partitions” on page 72.

Redistribute Free Space Wizard

The Redistribute free space wizard spreads the free space on a hard disk evenly across 
partitions. Free space refers to unused space within partitions and space that is not 
allocated to any partition.

You can redistribute free space on one hard disk at a time. You cannot redistribute free 
space across several disks.

For information about redistributing free space without the wizard, see “Resizing and 
Moving Partitions” on page 72.

Merge Partitions Wizard

The Merge Partitions wizard helps you merge two adjacent FAT or FAT32 partitions. You 
choose two partitions, and the first will be expanded to include the second. The contents of 
the second partition are added as a folder inside the first partition.

Copy Partition Wizard

The Copy Partition wizard Helps you make an exact duplicate of a partition. The copy is 
the same size (or slightly different if copied to another physical disk with a different 
geometry) and file system type and contains the same data as the original. When you copy 
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a partition, you specify the hard disk and the unallocated space where you want to place 
the copy. If necessary, the wizard will resize neighboring partitions to create sufficient 
space to perform the copy.

Hiding Wizard Icons

You can choose whether to display the wizard buttons near the bottom of the 
VolumeManager main window. Hiding the wizard buttons increases the display area of the 
partition list.

1 Click View ➤ Wizard Buttons.

A check mark displays by the menu command if the wizard buttons are displayed. 
Choose the command again to redisplay the buttons.

The setting you choose will remain in effect until you reset it.

Scripting

VolumeManager includes the ability to change the partitions on a computer by running a 
script that you create with ScriptBuilder. The script is an ASCII file with text statements 
that define the operations to take place. To run a script, you pass the script filename to the 
program on the command line.

For additional information about script processing, refer to the VolumeManager online 
help or the VMSCRIPT.PDF file on the VolumeManager CD. The VMSCRIPT.PDF file 
also includes information about startup switches for VolumeManager.
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C H A P T E R12
Remote Agent
This chapter includes the following information:

• Remote Agent Overview

• Creating Remote Agent Boot Disks

• Using the Remote Agent Boot Disk

• Accessing a Remote Server
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Remote Agent Overview

Remote Agent (RA) is a DOS application that is executed on a server that 
VolumeManager can contact across the wire using a TCP/IP connection. Using Remote 
Agent, you can:

• Copy or move partitions between the remote server running the Remote Agent boot 
disk and the Windows NT/2000 server running VolumeManager.

• Copy and consolidate a volume set on the Windows NT Server running 
VolumeManager to a new partition on the remote server running the Remote Agent 
boot disk

• Delete a remote partition

• Create a remote partition

• Check the integrity of a remote partition

You cannot copy, move, or resize partitions on a remote server when the operations would 
be applied exclusively on the remote server. Instead, after you have copied or moved data 
to a remote server, you should reboot the server without using Remote Agent, start 
Windows NT, and use VolumeManager locally. You can also run VolumeManager locally 
to resize partitions and perform other operations that are not available with the Remote 
Agent.

Three-Step Process

Using the Remote Agent involves three steps:

1 Create the Remote Agent boot disk using the Boot Disk Builder program. Refer to the 
Boot Disk Builder online Help file for instructions on creating the remote agent boot 
disk.

You will use the disk to boot the remote server, so the Windows NT/2000 server 
running VolumeManager can communicate with the remote server.

2 Boot the remote server using the Remote Agent boot disk you created in step 1.

3 Access the remote server (using the Connect Remote Agent option) from the 
Windows NT server running VolumeManager.

You are ready to perform operations between the Windows NT/2000 server and the 
remote server.

Partitions on the remote drive will appear in the tree view on the left side of the main 
window, so you can choose them like you would any local partition.
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Creating Remote Agent Boot Disks

You must create a Remote Agent boot disk to run Remote Agent. You can create the disk 
with Boot Disk Builder.

Boot Disk Builder

Boot Disk Builder helps you build a boot disk to run Remote Agent. Boot Disk Builder is 
installed when you install VolumeManager.

1 From the Windows taskbar, click Start ➤ Program Files ➤ VolumeManager 2.0 ➤ 

Boot Disk Builder.

2 From the Boot Disk Builder window, click Next.

To use the same configuration options you chose in a previous session of Boot Disk 
Builder, click File ➤ Load Configuration from the main Boot Disk Builder screen, 
choose the configuration file (*.BDC) you want, then click Open.
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3 If your network adapter is listed, go to step 8. If your network adapter is not listed, 
click Add, specify the location of the driver information file (*.INF) for your network 
adapter, then click Next.

4 Choose one or more adapters from the list, then click Next.

5 Specify the Novell NetWare DOS client driver file, then click Next.

6 Click Finish.

7 Select the network adapter you are using from the list box.
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8 Click Next.

9 Click Obtain an IP address from a DHCP server if a DHCP server is used (the net 
mask and default gateway are automatically provided).

Or specify the IP address and subnet mask if there is no DHCP server.

Ethernet II will display as the frame type for your network.
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10 Click Next.

11 Click the drive letter where you are creating the DOS boot diskette, or click Copy 
boot disk contents to a folder and specify the full path to the folder you want.

12 Insert a formatted diskette.

If you have a boot disk and you want to use your regular DOS files instead of the 
Caldera DOS files included with Boot Disk Builder, complete the following items:

a Insert your boot disk, then click Tools ➤ Load DOS Reference Diskette ➤ From 
A:. The files from your boot disk will be copied to a REFDISK directory where 
Boot Disk Builder is installed. If there are too many to include along with the 
necessary files that Remote Agent needs, you can delete everything but 
CONFIG.SYS and any drivers started within the CONFIG.SYS file.

b Select Use Reference Disk for DOS Files at the bottom of the dialog box.

c Remove your original boot disk and insert a formatted disk that will become the 
Remote Agent boot disk. (If you do not remove your original disk, Boot Disk 
Builder will overwrite the files on it.)

13 If you want to save your choices for later use, click File ➤ Save Configuration, then 
name and save the file.
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14 Click Back to make any changes, or click Finish to build the boot disk.

After the boot disk has been created, you can create another boot disk.

When you use the boot disk, Remote Agent will start, and you can specify the IP address 
settings. You can then perform operations “across the wire.”

Boot Disk Files

The Remote Agent boot disk will contain the following files:

• COMMAND.COM
• Device drivers for your network card
• AUTOEXEC.BAT
• LSL.COM
• MOUSE.COM
• NET.CFG
• RA.EXE
• WATTCP.CFG

If the remote server has a bootable partition, you can copy the files from the boot disk to 
that partition and run the Remote Agent from the hard disk.

Using the Remote Agent Boot Disk

1 Insert the RA boot disk into the floppy drive of the remote server, and boot the server.

The Remote Agent dialog box appears. Notice that it is waiting for a connection from 
VolumeManager on the Windows NT/2000 server.

Specifying the IP Address of the Remote Server

The first time you run RA on the remote machine, you may need to specify network 
configuration settings.

1 From the Remote Agent dialog box, click Settings.

2 Click Obtain an IP address from a DHCP server if a DHCP server is used.
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Or, click Specify an IP address, then enter a static local address, net mask, and 
default gateway.

3 Click Save. 

The information you specify in the Local Settings dialog is saved in the 
WATTCP.CFG file on the boot disk.

Notice that the Remote Agent is now ready and waiting for a connection from 
VolumeManager on a Windows NT/2000 server. After a connection is established, you can 
send operations (such as copying a partition) from the Windows NT/2000 server to the 
remote server.

Accessing a Remote Server

After you have booted the remote server using the Remote Agent boot disk, you are ready 
to access the remote machine from VolumeManager on the Windows NT/2000 server.

1 From the Windows NT/2000 server machine, run VolumeManager.

2 Click General ➤ Connect Remote Agent, or click  on the toolbar.

3 Type the local IP address of the server running the Remote Agent.

4 Click Connect.

5 Choose the operations you want to perform on the remote machine.

Operations that are not available are dimmed on the menu.
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C H A P T E R13
Creating a New Boot Drive
This chapter includes the following information:

• Installing a New Server Disk

• Reusing the Old Server Disk
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Installing a New Server Disk

VolumeManager is particularly useful if you have a new, larger hard disk that you want to 
become the boot disk for your server. Not only does VolumeManager save you the time of 
reinstalling Windows NT, it also ensures that the new server disk contains exactly the 
same information as the old server disk.

To move your server installation from an old hard disk to a new hard disk: 

1 Install any drivers you may need for the new drive onto the server operating system.

Usually this step is required only if you are installing a new I/O card on your system 
and you did not install the drivers previously.

2 Shut down the server and turn off the power.

3 Install the new drive as a non-boot device.

This step may require changes to the drive jumper, BIOS, or I/O card settings. 
Consult your hardware manuals for more information.

4 Power on the server and configure the drive.

This step is necessary only if you are adding a new RAID system and need to set the 
RAID level before booting to the operating system.

5 Boot the server to the operating system.

6 Use VolumeManager to copy all partitions on the current drive to the new drive.

7 Resize the partitions as desired.

8 Designate the operating system partition on the new drive as the active partition.

9 Apply all your changes in VolumeManager.

VolumeManager will reboot the server and apply all changes in boot-time mode.

10 Immediately after VolumeManager applies all the operations and reboots the server, 
turn off the power.

11 Remove the old drive from the server. Keep the drive unchanged until you confirm 
that the new disk boots properly.

12 Change the new drive to be the boot device.
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This step may require changes to the drive jumper, BIOS, or I/O card settings. 
Consult your hardware manuals for more information.

13 Turn on the server.

The server should boot from the new disk. Make sure that all drive letters on your 
server match the drive letters previously assigned.

Windows NT/2000 will detect changes to the operating environment and may reassign 
drive letters on the new drive to a different order from what you had previously. The drive 
letters must be in the same order on your new drive for your server to function properly. If 
the Windows NT/2000 operating system partition drive letter is incorrect you may need to 
reboot your server more than once to return it back to the desired letter.

Reusing the Old Server Disk

After confirming that the new hard disk is working properly, you can reuse the old server 
hard disk.

1 Shut down the server and turn off the power.

2 Install the old drive as a non-boot device.

This step may require changes to the drive jumper, BIOS, or I/O card settings. 
Consult your hardware manuals for more information.

3 Boot the server to the operating system.

4 Use VolumeManager to delete all partitions and create new partitions on the old drive.
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A P P E N D I XA
Using VolumeManager With 
Other Programs
This appendix includes the following information:

• Virus Protection Software

• Compaq Insight Manager (CIM)
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Virus Protection Software

Norton AntiVirus

Before you run VolumeManager, disable virus protection services on boot or shut down 
virus protection services. Because Norton AntiVirus (NAV) interprets changes to partition 
tables and boot records as potential virus attacks, VolumeManager takes steps so that NAV 
automatically reinoculates. If NAV gives you the choice of repairing the changes, do not 
select Repair. Instead, inoculate after using VolumeManager. 

Other Virus Protection Software

VolumeManager modifies the master boot record and partitions’ boot sectors. Virus 
protection software should be able to detect that VolumeManager is changing partition 
tables and not boot code; however, virus protection programs could mistake 
VolumeManager’s changes as attempts to install a virus. If this occurs, turn off the virus 
protection program while using VolumeManager and inform the virus protection software 
manufacturer of the problem. 

Some motherboards contain virus protection software within the BIOS. If this causes a 
problem when you are running VolumeManager, disable the BIOS virus protection, then 
restart VolumeManager.

Compaq Insight Manager (CIM)

When you attempt to run VolumeManager on a Compaq server in which CIM Agents are 
installed and running, you may receive error 10,032. This error occurs because 
VolumeManager must access your drives at levels CIM Agents do not allow. To avoid this 
problem, you must stop all CIM Agents on the server and then run VolumeManager. 
(Refer to your CIM Agent documentation if you are unsure how to stop CIM Agents.) 
After VolumeManager has completed all operations, you can safely restart the CIM 
Agents.
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A P P E N D I XB
Troubleshooting
This appendix includes the following information:

• General Troubleshooting

Assigning a CD-ROM Drive Letter

Using VolumeManager With a SCSI Hard Disk

Resolving Check Errors

Resolving Partition Table Errors

Partition Tables and Viruses

Partition Will Not Boot After Resizing

• Generating Diagnostic Reports with PartitionInfo

• Error Messages and Solutions
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General Troubleshooting

This section addresses the following situations:

• Assigning a CD-ROM Drive Letter
• Using VolumeManager With a SCSI Hard Disk
• Resolving Check Errors
• Resolving Partition Table Errors
• Partition Tables and Viruses
• Partition Will Not Boot After Resizing

Assigning a CD-ROM Drive Letter

VolumeManager does not allow you to assign drive letters to CD-ROM drives or other 
removable media drives. Use Disk Administrator to perform these operations.

Using VolumeManager With a SCSI Hard Disk

To use VolumeManager on a SCSI hard disk, you must have a SCSI controller card that 
supports software Interrupt 13. Most SCSI controller cards let you enable software 
Interrupt 13 support in the BIOS through the card. If your SCSI controller card does not, 
contact the manufacturer to determine if your adapter can support software Interrupt 13. 
As a general rule, if you are able to use FDISK to partition the disk, you will also be able 
to use VolumeManager.

Resolving Check Errors

VolumeManager checks the integrity of a partition thoroughly before making changes to 
it. The Check for Errors and Info operations perform the same checks and display error 
messages when they discover problems. For more information, see “Checking Partitions 
for Errors” on page 86 and “Getting Information About Partitions” on page 91. These 
checks are similar to those made by Windows NT CHKDSK.

VolumeManager also checks a partition after modifying it. While data loss is possible, it is 
highly unlikely. The problem is usually a minor file system error that CHKDSK /F can 
correct without data loss. For more extensive errors, you may need to restore your files 
from a backup copy. If problems persist, report the problem to PowerQuest technical 
support.

If you receive an error message on any partition, back up your hard disk and then run 
CHKDSK on that partition; do not use the /F switch on the initial run. CHKDSK generally 
discovers the same problems as VolumeManager. 
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If CHKDSK does not show the same errors as the Check for Errors operation, contact 
PowerQuest technical support.

If CHKDSK and the Check for Errors operation detect the same errors, which is usually 
the case, run CHKDSK /F to fix the problems. Then run CHKDSK again without the /F 
switch to ensure that the partition is error free.

When CHKDSK reports no errors on the partition, run the Check for Errors operation. If 
VolumeManager still reports a problem, reformat the partition and restore your files from 
the backup copy.

Resolving Partition Table Errors

Partition table errors are errors in the 100 - 199 range. In most cases, you must resolve 
partition table errors by creating new, error-free partition tables. The general steps are: (1) 
ensure you have no viruses (see below), (2) back up the data on the affected partitions, (3) 
delete the partitions, (4) recreate them, and (5) restore their contents. You may need to use 
the FDISK program from a recent DOS version, as earlier versions may refuse to delete 
HPFS or hidden partitions, and the OS/2 FDISK program may recognize the partition’s 
corruption and refuse to modify it.

In some cases, you can resolve partition table errors manually. Run PartitionInfo to 
determine the errors on your partitions. PowerQuest technical support can help resolve 
partition table errors if you e-mail the PartitionInfo report to support@powerquest.com. 
Refer to “Generating Diagnostic Reports with PartitionInfo” on page 152 for additional 
information about PartitionInfo.

Partition Tables and Viruses

If partition changes made under one operating system are not reflected under another, and 
vice versa, a master boot record (MBR) virus may be present.

Use a virus check utility that can detect the latest viruses. If a virus is found, data loss is 
likely. Before removing the virus, boot each operating system and use the Check for Errors 
operation to evaluate the integrity of the partition. Back up the files on any partition that 
passes the Check for Errors operation. Then remove the virus and perform the Check for 
Errors operation on the partitions again. Delete and recreate any partitions that fail the 
check. Finally, reinstall the operating systems and restore the backup files as necessary.

Partition Will Not Boot After Resizing

Occasionally, resizing a FAT partition displaces the first few files on the partition (such as 
IO.SYS and MSDOS.SYS if the partition contains an operating system). If you resize a 
boot partition and then it fails to boot, run SYS.COM from DOS.
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Generating Diagnostic Reports with PartitionInfo

PartitionInfo (available in English) generates a report showing the contents of your hard 
disk partition table. This information is helpful in resolving various partitioning problems. 

You can run PartitionInfo under Windows 95, Windows 98, Windows Me, Windows NT, 
and Windows 2000. Under DOS or Windows 3.x, run PARTINFO.EXE (see page 153).

Every time you run VolumeManager, it creates a snapshot file PQ_DEBUG.TXT that 
includes information about all the disks and partitions on your machine. The file is saved 
in the %SystemRoot%\system32 directory. The PQ_DEBUG.TXT file may be beneficial 
for PowerQuest technical support if you call PowerQuest for help resolving problems with 
VolumeManager.

1 Click Start ➤ Program Files ➤ PowerQuest VolumeManager 2.0 ➤ 
PartitionInfo. 

The PartitionInfo window appears, displaying partition and disk geometry 
information and disk and partition errors. Disk geometry information includes data 
from the master boot record and the extended partition boot records.

Only errors that display in the box near the top of the screen indicate problems. Do 
not be concerned with Warnings and Infos in the bottom two boxes.
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2 From the Physical Drive drop-down list, select the disk for which you wish to view 
information.

3 You can save the PartitionInfo report as a file, or you can print it.

4 To exit PartitionInfo, click Close.

Generating Diagnostic Reports with PARTINFO.EXE

You can also run PARTINFO.EXE from the first rescue disk to get partition information. 
The PARTINFO program provides essentially the same information as the PartitionInfo 
program but without the Windows interface.

1 Boot the computer to DOS.

2 Insert the first rescue diskette, and change to the drive the diskette is in.

3 You have several options for running PARTINFO. 

To do this: Do this:

Save the report as a file Click Save As. In the Filename box, type a name 
for the file. Click Save. (Columns of information 
are separated by tabs, so you can open the file in a 
word processor and easily format the report.)

To change the font for a 
printed report

Click Printer Font. Select the desired font, font 
style, size, and so forth. Click OK.

To change printer setup Click File ➤ Printer Setup. We recommend that 
you set the page orientation to landscape to avoid 
text being cut off at the right margin.

To print a report Click Print, then click OK.

To do this: Do this:

To display partition 
information on your screen

Type PARTINFO, then press <Enter>.

To send a report directly to 
your printer

Type PARTINFO >LPT1 or PARTINFO 
>PRN, then press <Enter>.

To save the report as a text file 
on a floppy disk

Type PARTINFO >A:\PARTINFO.TXT, 
then press <Enter>.
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Error Messages and Solutions

VolumeManager error messages and possible solutions are listed below by number. The 
messages are also grouped in number ranges by error category. 

If you encounter an error not included in this user guide, go to 
support.powerquest.com/publisher and choose Quick Search under Solutions Center. 
Then choose Master Error List.

Miscellaneous Errors (3–38)

#3 Not enough memory

This error can occur when you are resizing, moving, or copying an extremely 
large partition (60 GB) or when manipulating smaller partitions in DOS with 
EMM386 loaded. EMM386 limits the amount of memory the program can 
access. To solve the problem, modify your CONFIG.SYS file by commenting the 
EMM386 line. For more information about memory requirements, see 
“VolumeManager System Requirements” on page 6.

The DOS VolumeManager executable requires a minimum of 585 KB of 
memory in the first 640 KB of the computer’s address space (conventional 
memory) and 8 MB of total memory. For possible solutions if you have 
insufficient conventional memory, see “Assigning a CD-ROM Drive Letter” on 
page 150.

#8 Could not allocate/deallocate DOS real mode memory

The DOS VolumeManager executable running under DOS, Windows 3.x, 
Windows 95, and Windows 98 requires some memory in the first 1 MB of the 
computer’s address space. (VolumeManager uses a DOS extender.) If not enough 
memory is available, VolumeManager cannot access the hard disk. For possible 
solutions, see “Assigning a CD-ROM Drive Letter” on page 150.

#27 Cannot lock drive 

Under multitasking operating systems such as Windows 95, VolumeManager 
must lock a partition before it can safely modify it. If the hard disk contains files 
that are in use by another process, VolumeManager cannot lock the partition. 

#29 Cannot lock a locked drive

Verify that the partitions you are attempting to modify are not on a locked hard 
disk.
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#34 The time has expired on this evaluation version

PowerQuest occasionally releases beta versions and evaluation versions of 
VolumeManager. Both versions are not as safe as release versions; therefore, 
PowerQuest builds an expiration date into each version. After a predetermined 
test period, the beta or evaluation version no longer functions. 

Disk Access Errors (40–56)

Errors in the 40–56 number range indicate that accessing your disk is not possible, and 
often result from hardware problems. Some problems may have simple solutions; for 
others, the only solution may be replacing the hard disk. When possible, VolumeManager 
detects major errors before any changes have been made so you can back up your data 
before replacing the hard disk.

#45 CRC error in data

When VolumeManager or any other program reads information off of a hard                     
disk, it checks the CRC (cyclic redundancy check) information contained in                     
each sector. If it performs a CRC test and the result is different from the                     
value stored on that sector, there is a CRC error. This usually means one of                     
two things.

• The file being read has become corrupted by some other means.
• A sector used in the file’s storage has become bad and corrupted                     

that part of the stored file.

The solution is to do a surface test to make sure any bad sectors are marked as 
bad, then reinstall the software involved to ensure that files on the system are not 
corrupted.

If you have two IDE hard disks that are sharing the same cable, try putting the 
drives on separate cables.

You may also want to try running VolumeManager with an /IRE (ignore 
redundancy errors) switch. 

#48 Sector not found

This error can be reported when a given sector cannot be read or written to.                
There are many possible causes.

If you are encountering this error, make sure that your BIOS supports the 
operating system and hard disk on the system. Also run a thorough ScanDisk on 
the drive to prevent data from being written to bad sectors. 
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#49 Write fault 

#50 Read fault

(The following information applies to errors 49 and 50.) 

VolumeManager is unable to write to/read from a specific sector on the hard disk. 
Possible causes include:

• If your PC beeps or displays a black box in the middle of the screen, virus 
protection is enabled in your computer’s BIOS. Disable virus or boot sector 
protection in the BIOS.

• A virus protection application (which may be a TSR or DLL program) is in 
use. Disable the application before using VolumeManager.

• There is a bad sector on the hard disk (this is usually the case only with older 
hard disks). Run ScanDisk on the hard disk to perform a surface scan to verify 
the existence of bad sectors. If your drive has bad sectors, we recommend you 
replace it.

• You have set up disk mirroring with PC-Tools. Disable the disk mirroring 
option.

Miscellaneous Errors

#98 Hibernate Windows 2000

Hibernation saves the system RAM to a file, then uses Advanced Power 
Management to shut the system down. When the machine is subsequently booted, 
the hibernation file is read into RAM, and execution begins where it left off.

A hibernated system assumes when it is booted that the system is in the same 
state as when hibernation occurred. Any changes made to the system’s hardware 
(including disks and disk partitions) may cause unexpected results.

See Microsoft’s Knowledge Base article #241354 for more information about 
making modifications to a system while in hibernation mode.

To avoid this error, shut down your machine normally and then restart.

Partition Table Errors (100–199)

Errors in the 100–199 number range are partition table errors. For general information 
about resolving these errors, see “Resolving Partition Table Errors” on page 151 and 
“Partition Tables and Viruses” on page 151.
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#100 Partition table is bad

The master boot record (MBR) can contain, at most, one extended partition, and 
each extended partition boot record (EPBR) can contain, at most, one link to 
another EPBR. This error occurs when a partition table violates the foregoing 
rule. It can also occur if you have more than one active partition. Since any 
modifications VolumeManager makes may decrease the amount of data that is 
recoverable from the hard disk, VolumeManager does not recognize any of the 
hard disk’s partitions. If you must create new, error-free partition tables to 
resolve your problem, see “Resolving Partition Table Errors” on page 151 for 
instructions.

#104 No sectors in partition 

No partition should contain zero sectors. Delete the partition before using 
VolumeManager. 

#105 Partition starts on wrong boundary 

The hard-disk partition table contains erroneous values. VolumeManager expects 
partitions to begin and end on the correct cylinder boundaries. If they do not, the 
disk may be partially corrupted. In this circumstance, if VolumeManager were to 
make any modifications it might cause the loss of data. Therefore, 
VolumeManager refuses to recognize any of the hard disk’s partitions. To resolve 
this problem, see the instructions in “Resolving Partition Table Errors” on page 
151.

#106 Partition doesn’t start with sector one

See error #105.

#107 Partition begins after end of disk 

This error can occur if a partition erroneously extends beyond the physical end of 
the hard disk. This may happen if the hard disk has been used on a different 
computer or with a different hard-disk controller or if BIOS settings have been 
changed. Be advised that the physical geometry of the hard disk may differ from 
the logical geometry assigned to the hard disk by the operating system.

#108 Partition doesn’t end at end of cylinder 

See error #105.

#109 Partition ends after end of disk 

See error #107.
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#110 Partition table number of sectors is inconsistent 

The hard-disk partition table contains two inconsistent descriptions of the number 
of sectors on the hard disk. This error is serious if both DOS and another 
operating system use the hard disk. Because DOS uses one description and other 
operating systems may use the other, data loss is likely once the partition is 
almost full. To resolve this error, see the instructions in “Resolving Partition 
Table Errors” on page 151.

#111 The order of entries in the EPBR is not correct.

An extended partition boot record (EPBR) is a sector on the hard disk that 
contains a partition table. The EPBR partition table is special because it generally 
only has two valid entries: one for the logical partition and one that is a pointer to 
the next EPBR. The standard is for the logical partition's entry to be the first entry 
in the table and the second entry is the pointer to the next EPBR. The third and 
fourth entries are not used. For some utilities, such as IBM's Boot Manager, the 
order of these entries is important because the utility expects the first entry to be 
the logical and the second entry to be the pointer to the next EPBR. If 
VolumeManager detects that the EPBR entries are out of order, you will be 
prompted to fix the error. If you choose to fix the error, VolumeManager will 
reorder the EPBR entries for you automatically.

#112 Logical partition ends outside Extended 

See error #111. 

#113 Partitions overlap 

The hard-disk partition table contains erroneous values. If data partitions overlap, 
writing to one may destroy data in another.

If a primary partition overlaps the end of the extended partition but does not 
overlap any logical partitions within the extended partition, the problem can be 
remedied by patching the partition table. Only qualified individuals should 
attempt this repair! An incorrect patch could destroy all data on the hard 
disk! In most instances, you should resolve the problem as explained in 
“Resolving Partition Table Errors” on page 151.

#116 Partition table Begin and Start inconsistent

The hard-disk partition table contains two inconsistent descriptions of the 
partition’s starting sector. This error can occur if the operating system reports a 
hard-disk geometry that is different than the geometry in use when the partition 
table was written. Possible causes include: (1) different operating systems (for 
example, DOS and OS/2) report different hard-disk geometries, (2) you boot 
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from a diskette that loads a different driver than is loaded when you boot from the 
hard disk, (3) upgrading the operating system (for example, from OS/2 2.x to 
OS/2 Warp) causes a different driver to be used, (4) the hard disk or controller 
has been changed, (5) the BIOS has been upgraded, (6) the BIOS LBA setting has 
been changed, or (7) there is a partition table virus present on the hard disk.

In most instances, you should resolve the problem as explained in “Resolving 
Partition Table Errors” on page 151. You can also use a virus scanning program 
to remove any partition table virus. Data loss is possible if the number of heads or 
sectors per track has changed since you first created your partitions.

#120 The logical drive chain is incompatible 

This error occurs under some operating systems when logical partitions are not 
chained together in the expected order. DOS, OS/2, Windows 95, Windows 98, 
and Windows NT require that logical partitions be chained together in ascending 
order. Some other operating systems do not require this. For example, some 
versions of the Linux FDISK utility chain logical partitions together in the order 
they are created. This error message identifies a very dangerous situation; using 
the DOS FDISK in this situation can cause loss of one or more partitions. 

For solutions to this problem, see the instructions in “Resolving Partition Table 
Errors” on page 151. If you decide to back up your data and recreate your 
partitions, you may have to use the same partitioning program that you used to 
create the partitions in order to delete them.

#121 The first sector of the drive cannot be read 

The first sector of the hard disk (cylinder 0, head 0, sector 1) contains the master 
boot record (MBR) and the primary partition table. VolumeManager cannot make 
changes to this hard disk because an error occurred when it read the first sector. 
See error #50 for information on resolving this error.

#122 A bad sector was found in the current or new partition area 

The partition cannot be moved safely because there is a bad sector in the new or 
current partition area. When you see this error message, the move operation is 
aborted before any corruption can occur. Try moving the partition to a different 
place. If your hard disk has bad sectors, we recommend that you replace the hard 
disk.

#140 Overlapping partitions found. No partitions can be undeleted.

Two or more deleted file systems were found in the unallocated space. However, 
each file system claims space that another file system also claims. There are no 
other partitions that can be undeleted.
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Networking Errors (200-299)

#202 Network read failed
#203 Network write failed

Socket read or write was unable to read or write the requested amount of data. Be 
sure the network connection is working properly. If this error occurs during an 
operation, the destination partition and partition table may be corrupted. If this 
happens, you must delete the affected partition, repair the partition table, and redo 
the operation.

#215 The connection was aborted due to timeout or other failure

The established connection was locally aborted. Be sure that the network 
connection is working properly. If this error occurs during an operation, the 
destination partition and partition table may be corrupted. If this happens, you 
must delete the affected partition, repair the partition table, and redo the 
operation.

#217 Attempt to connect timed out without establishing a connection

The network connection timed out. Be sure that the network connection is 
working properly. If this error occurs during an operation, the destination 
partition and partition table may be corrupted. If this happens, you must delete 
the affected partition, repair the partition table, and redo the operation.

#218 The attempt to connect was forcibly rejected

The network connection was refused. No connection could be made because the 
target machine actively refused it. This error occurs when you attempt to connect 
to a remote machine from VolumeManager but there is already another server 
connected to it. You must wait until the other server has disconnected from the 
remote machine.

#220 The Link Support Layer (LSL) driver and supporting NIC driver are not 
loaded.

Ensure that the LSL driver and appropriate NIC driver are on the Remote Agent 
boot disk and are being loaded before you run Remote Agent.

#221 The connection was reset by peer executing a hard or abortive close

The connection was forcibly closed by the remote host. This error generally 
indicates that the peer application on the remote host was suddenly stopped or the 
host was rebooted. This error may also result if a connection is broken due to 
keep-alive activity detecting a failure while one or more operations are in 
progress. Operations that were in progress fail. If this error occurs during an 
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operation, the destination partition and partition table may be corrupted. If this 
happens, you must delete the affected partition, repair the partition table, and redo 
the operation.

#223 No buffers declared for Link Support Layer (LSL) driver in NET.CFG.

No buffers have been declared for the Link Support Layer (LSL) driver in 
NET.CFG on the Remote Agent boot disk. Edit the NET.CFG file to ensure that 
the link support section has buffers declared.

#224 Buffer size for Link Support Layer (LSL) driver in NET.CFG is too small

The buffer size for the Link Support Layer (LSL) driver in NET.CFG on the 
Remote Agent boot disk is too small. Edit the NET.CFG file, and ensure that the 
link support buffer size is at least 1600.

#225 The Link Support Layer (LSL) driver does not support ETHERNET_II 
frames

In NET.CFG on the Remote Agent boot disk, the Link Support Layer (LSL) 
driver does not support ETHERNET_II frames. Edit the NET.CFG file on the 
Remote Agent boot disk, and ensure that the link driver section specifies the 
ETHERNET_II frame type.

Check Errors (500–599)

Check errors occur when VolumeManager checks the integrity of a partition. For general 
information about resolving these errors, see “Resolving Check Errors” on page 150.

#500 Subdirectory is corrupted 

This error message reveals the name of the corrupted subdirectory. Back up the 
contents of that directory and its subdirectories. You can then delete the corrupted 
subdirectory.

#501 Cross-linked files were found

Multiple files claim the same clusters. VolumeManager can fix this error when it 
occurs on an NTFS partition. For more information, see “Checking Partitions for 
Errors” on page 86. VolumeManager lets you fix this error by: (1) copying the 
shared clusters to each affected file, (2) deleting all affected files, or (3) keeping 
one file and deleting the other affected files.
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#506 Not enough free space on partition to shrink

Some free space (which is dependent on the hard disk’s current contents) is 
required to resize a partition smaller. Delete unneeded and duplicate files in the 
partition and then attempt the operation again.

#508 As specified, the operation does not change the partition

You have entered a value that is the same as or (when rounded to the required 
cylinder boundary) rounds to the same as the partition’s present value. Enter a 
larger change.

#509 A bad sector was detected in the current or new FS area 

In order to perform the resize operation that you requested, VolumeManager 
attempted to expand the file system area. However, the program found a bad 
sector in the new area. Try moving the partition before you resize it. No 
corruption occurs when you encounter this error.

#510 The version of the file system is not supported

An updated version of VolumeManager is required to operate on this new version 
of the file system. Visit www.powerquest.com/updates for information about 
updated versions of VolumeManager.

Batch Errors (600–633)

#600 Error trying to create batch file 
#601 Error trying to write batch file
#602 Batch file not found

(The following information applies to errors 600–602.) 

VolumeManager lets you specify a series of changes you want to make to your 
partitions, and then executes all the changes when you click Apply. At this point, 
VolumeManager writes out a command list file (called a “batch file”) to disk in 
preparation for execution, and then reads the file upon execution (immediately if 
a lock can be secured on all impacted partitions, or in a special “reboot” mode 
after rebooting your computer if not all locks can be secured). In the Windows 
NT version of VolumeManager, the batch file is located in your 
Windows\System directory. In the rescue diskette version, it is located in the 
directory from which VolumeManager is running. The batch filename is 
PQ_VM20.PQB.

If the batch file cannot be created, cannot be written, or cannot be located when 
VolumeManager attempts to execute the command file, the above error messages 
appear. You should contact PowerQuest technical support.

http://www.powerquest.com/updates
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#603 Unknown batch operation

The batch file contained an operation unknown to VolumeManager. Contact 
PowerQuest technical support.

#625 Changes cannot be applied

Generally error 625 only occurs when the system needs to go into boot-mode to 
execute your commands. A 625 error occurs when your disk geometry is seen 
differently in your native Windows version of VolumeManager than it is in the 
boot-mode version. For security reasons, VolumeManager cannot apply your 
changes without risking data loss.

One common configuration that will cause a 625 error is a system that has a hard 
disk (such as a SCSI or removable drive) that is visible in Windows but that 
cannot be seen in the boot-mode environment.

Some possible solutions include:

• Make sure the operation executes in native Windows mode (without resorting 
to boot-mode execution). VolumeManager will only go into boot-mode if it 
cannot lock a partition (that is, if there are any open files on the partition). Try 
to confine all operations to drives VolumeManager can lock before clicking the 
Apply Changes button.

• Change the configuration of the offending disk (most likely the SCSI or 
removable drive) by changing the BIOS setup for that disk. Doing so will 
ensure that the native and boot-mode environments detect identical hard disk 
configurations. If this does not work, you can try temporarily disabling the 
offending disk.

This error usually indicates that some other application has modified your disk 
configuration while you were running VolumeManager. Make sure no other 
applications are loaded while VolumeManager is running.

User Interaction Errors (950–999)

#950 Unable to detect any disk drives 

No partitionable hard disks were found on your computer. Diskette drives and 
many removable media drives do not support partitioning. VolumeManager 
cannot perform operations on disks in such drives.

#951 An invalid value was entered

The value entered is outside the range or (when rounded to the required cylinder 
boundary) rounds to a value that is outside the range for the operation specified. 
Check the displayed range and reenter the value.
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#952 Value entered is the same as the current value 

See error #508.

#963 Selected operation is currently invalid

Not all VolumeManager operations can be performed on all partitions. For 
example, you cannot convert an HPFS partition to NTFS, and you cannot create a 
partition if there is not enough unallocated space on the hard disk.

Under Windows, options that are not available either do not appear on the menus 
or they appear dimmed. However, if you are running scripts with the DOS 
version, there are no menus so you cannot see which operations are available. 
Refer to the relevant information in this user guide or the online Help for 
restrictions that explain why an operation is not available.

#967 Could not perform operation to the value specified 

This error occurs only when you run VolumeManager from a script. If the value 
specified on a resize or move operation is not between the minimum and 
maximum possible, script execution stops and this error displays.

#969 Incorrect Volume Label entered, Unable to proceed. 

To format an existing partition, VolumeManager requires you to type OK to 
confirm that you want to format the partition. If the volume label you enter does 
not match the volume label of the partition you are attempting to format, this 
error appears.

#970 Invalid Bad Sector Check value specified 

This error occurs only when you run VolumeManager from a script. If the script 
command SET DEFAULT BAD SECTOR TEST STATE is not followed by 
either ON or OFF, this error appears. 

#971 The label entered was too long 

When you enter a volume label, the process that checks the validity of the label 
displays this message if the label is too long. The label must be no longer than 11 
characters for FAT or FAT32 partitions or 32 characters for NTFS partitions.

#972 Invalid characters in the label

When you enter a volume label, the process that checks the validity of the label 
displays this message if the label has characters that are invalid. Invalid 
characters include the following: [ * ? : < > | + = ; \ / ” , ].
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#973 Volume Label cannot have leading spaces 

When you enter a volume label, the process that checks the validity of the label 
displays this message if you enter a label in which a space or spaces are the 
leading characters. 

#974 Root size specified was not in the valid range 

This error occurs only when you run VolumeManager from a script. If you use 
the Create, Format, or Resize Root operations, and the number of root entries 
specified is not within the acceptable range for that partition, this error appears. 
Generally, the valid range is from 64 to 1,024.

#975 The cluster size specified was invalid for this partition

This error message displays only when you run VolumeManager from a script. 
Many commands have a cluster size option. If a script command specifies an 
invalid cluster size (for the type and size of the partition), this error appears.

#976 Cannot create the file system specified in the current space 

This error message displays only when you run VolumeManager from a script. 
When you use the Create or Format commands, you must also choose a file 
system type. If the file system or partition type you specified cannot be created in 
the space available, this error appears.

#977 Partition selected is invalid 

This error message displays only when you run VolumeManager from a script. If 
the partition selected from the Select Partition command is not a valid partition, 
this error appears.

#978 Unable to set to proper partition after last operation. Script halted.

This error message appears only when you run VolumeManager from a script. 
After each operation, VolumeManager ensures that the right partition is still 
selected. If VolumeManager is not able to select the proper partition, it ends 
script processing and displays this error.

#996 Invalid password

If you forget your VolumeManager password, go to the directory that contains 
VMDOS.EXE and delete PQMAGIC.PSW. Deleting this file removes the 
password protection from VolumeManager. You can then restart 
VolumeManager and, if you wish, set a new password.
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NTFS Check Errors (1500–1699)

Errors 1500–1699 are NTFS-specific check errors, which can occur when 
VolumeManager checks the integrity of a partition. VolumeManager can fix certain errors 
when you perform the Check operation. For more information, see “Checking Partitions 
for Errors” on page 86 and “Resolving Check Errors” on page 150.

In this section, “attribute” does not mean read-only, hidden, system, etc. Rather, 
“attribute” means one of a file’s data streams.

#1501 Wrong version of NTFS 

The partition was created using a version of the NTFS file format that 
VolumeManager cannot work with.

#1503 Bad NTFS cluster size 

The NTFS cluster size must be 512, 1,024, 2,048, 4,096, 8,192, 16,384, 32,768, 
or 65,536 bytes.

#1512 Restart record mismatch

The two restart entries in the journal file are different. This may happen if 
Windows NT Workstation is not properly shut down. To fix this problem, restart 
Windows NT Workstation and shut it down using the Shut Down command.

#1516 Partition improperly dismounted

The partition dirty flag is set in a restart record in the journal file. This error may 
have been caused by a power failure or system crash while the Windows NT 
operating system was writing the partition. Reboot Windows NT and execute 
CHKDSK /F to repair the damage.

#1527 Bad update sequence number

A buffer contains mismatched update sequence numbers. This error may have 
been caused by a power failure or system crash while the Windows NT operating 
system was writing to the partition. Reboot Windows NT Workstation and 
execute CHKDSK /F to repair the damage.

#1529 Information mismatch in directory entry

A file attribute stored in a file record is different from the attribute stored in its 
directory entry. If this error is in a system file (file 0–10), Windows NT 
CHKDSK does not fix it, but Windows NT rebuilds the root directory on the 
partition the next time the operating system is started.
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#1538 Can’t find contiguous space to move

The partition does not contain enough contiguous free space to hold the new copy 
of a file that must be contiguous. You normally encounter this error when you use 
the Resize option to resize a partition smaller.

#1539 File size mismatch

The size of a system file (file 0–15) recorded in its file record does not match 
either the size recorded in its directory entry in the root directory or the size of its 
data stream.

#1544 External attribute list in external attribute

An external file record has an external attribute list.

#1545 File attributes out of order

The attributes in a file must appear in order of increasing numeric type.

#1546 Attribute neither resident nor nonresident

The attribute resident flag has a value other than resident or nonresident.

#1547 Wrong run limits

A run has more clusters than the difference between its highest and lowest 
cluster.

#1548 File table has fewer than 16 entries

The file table must have at least 16 entries.

#1549 File table has more than 4 billion entries

The file table must have fewer than 4 billion entries.

#1604 File’s parent does not contain the file

The file’s parent directory does not contain a reference to the file, or a file’s size, 
date, or time information does not match the file’s parent directory information. 
This error can be fixed when you perform the Check operation. For more 
information, see “Checking Partitions for Errors” on page 86. When you fix this 
error, VolumeManager updates the file’s parent directory information.

#1609 Lost cluster(s)

The volume bitmap shows clusters as being used which are not used (no file 
claims them). This error can be fixed when you perform the Check operation. For 
more information, see “Checking Partitions for Errors” on page 86. 
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VolumeManager lets you fix this error by either deleting the lost clusters or by 
saving them in a file in the root directory. The filename is FILEXXXX.PQE, 
where XXXX is a number between 0000 and 9999.

#1630 Inconsistent sizes in attribute header

File size information is incorrect. This error can be fixed when you perform the 
Check operation. For more information, see “Checking Partitions for Errors” on 
page 86. When you fix this error, VolumeManager computes the correct file size 
information.

#1644 Bad system file sequence number

A system file has a bad sequence number. System files must have a sequence 
number from 1 to 15. A partition with this problem may pass Windows NT 
CHKDSK, but Windows NT does not mount the partition the next time the 
operating system is started.

#1647 Error in root directory index

There is an error in the root directory’s index. Running Windows NT CHKDSK 
does not fix this problem, but Windows NT automatically rebuilds the root 
directory on the partition the next time it is started.

#1681 Data is compressed or sparse

The NTFS file system cannot be converted to FAT or FAT32 because a file has 
been compressed. The conversion cannot run unless all files are decompressed. 
(The FRS number for the compressed file is shown.)

#1687 An object index is present

A file with an object index created by Windows 2000 was found. For example, 
users may have been assigned disk space quotas. When converting a partition to 
FAT or FAT32, this information will not be saved, since FAT and FAT32 file 
systems do not support object indexes. (The FRS number for the compressed file 
found is shown.)

FAT Check Errors (2000–2099)

Check errors occur when VolumeManager checks the integrity of a partition. For general 
information about resolving these errors, see “Resolving Check Errors” on page 150.

#2001 FAT copies are not identical

Run ScanDisk to fix this error.
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This problem may also be caused by a virus. Run a virus checker and remove the 
virus if possible.

#2002 There are invalid entries in the FAT

This error can generally be fixed by running a thorough ScanDisk on the 
partitions reporting the error.

#2003 File size does not match FAT allocation for file

Run ScanDisk or CHKDSK to fix this error.

#2005 One or more lost clusters are present

Run ScanDisk or CHKDSK to fix this error.

#2012 Formatted FAT file system too big for partition

This error can occur when:

• The number of sectors in the partition is larger than 65,536, and the 
bsHugeSects field of the boot sector (“Big total number of sectors” in Norton’s 
DISKEDIT utility) shows that there are more sectors in the partition than the 
partition table shows.

• The number of sectors in the partition is less than 65,536, and the bsSects field 
of the boot sector (“Total sectors on disk” in Norton’s DISKEDIT utility) 
shows that there are more sectors in the partition than the partition table shows.

This situation can result in data loss when the FAT file system tries to use space 
outside the partition that does not exist or that belongs to another partition. Since 
file data may exist outside the partition boundary, you cannot fix the problem by 
simply patching the boot sector.

To correct the error, back up all data on the partition, delete the partition, recreate 
the partition, and restore the data. Alternately, it has been reported that you can 
use Norton Disk Doctor to fix this problem.

#2013 A component of FAT geometry is bad

This error can occur when:

• The number of clusters on the hard disk is greater than the FAT limits allow. 
This can result from bad values in the boot sector for the number of sectors, 
FATs, root entries, reserved sectors, and sectors per cluster.

• The number of sectors in the FAT is not large enough to hold the number of 
clusters present on the hard disk.
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A qualified consultant may be able to fix the hard disk by performing simple 
patches. Alternately, you can back up the data on the partition, delete the 
partition, recreate the partition, and restore the files.

#2027 Too many root entries in the FAT32 partition to convert it to FAT16

Long filenames may be causing this problem, since they use multiple entries per 
file. To fix this error, move some of the root directory entries into a subdirectory 
and defragment the disk. 

#4002 Out of Memory

See error #3.

Operating System Errors (over 10,000)

Any number over 10,000 indicates an operating system error.

1 To determine the number of the operating system error, subtract 10,000. (For 
example, 10,032 - 10,000 = 32)

2 Open a command prompt window, and type net helpmsg x, where x is the error 
number you calculated in step 1. (For example, net helpmsg 32)

3 Consult your Windows NT system documentation or Microsoft’s TechNet web site 
(www.microsoft.com/technet/default.asp) for information about resolving the error.

For additional information about error 10,032, see “Compaq Insight Manager (CIM)” on 
page 148.

http://www.microsoft.com/technet
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A P P E N D I XC
PowerQuest Technical Support
This appendix includes the following information:

• Before Contacting Technical Support

• Support Life Cycle

• Contact Information
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Before Contacting Technical Support

Before contacting PowerQuest, please try to resolve problems you encounter by using the 
online Help, the user guide, the readme files, and PowerQuest's corporate web site.

Tips
• Your problem may be resolved by applying the most recent patch or upgrade of the 

software.

• PowerQuest technical support engineers may request information from the 
PartitionInfo utility program to help you resolve problems with PartitionMagic. See 
“Generating Diagnostic Reports with PartitionInfo” on page 152 for more 
information about PartitionInfo and PARTINFO. The PartitionInfo report is always 
required for errors 100-199, 986, and drive detection errors of any kind.

• Your product serial number is required to obtain technical support.

Support Life Cycle

Technical support is available to all registered users throughout the life of the product, 
which began when PowerQuest released the software to manufacturing and ends six 
months after the release of the next version of the software or when PowerQuest 
discontinues its development.

For information about PowerQuest's fee-based technical support or Professional Services 
offerings, please follow the Professional Services link at support.powerquest.com.

Contact Information

Corporate Web Site

The technical support web site, support.powerquest.com, includes an overview of support 
options, an e-mail support request form, a list of error messages and information to resolve 
problems you encounter, and answers to frequently asked questions about the product.

http://www.powerquest.com/support
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E-mail

*To obtain the most efficient e-mail technical support for specific technical questions, you 
should fill out the form at support.powerquest.com/emsupport.html (available in English 
only).

Fax

Fax a description of your problem to the technical support fax number. This service is 
available in the U.S., Canada, and Europe 24 hours a day, 7 days a week. PowerQuest 
technicians try to respond to all fax requests within 24 hours.

Language
E-mail (for specific 
technical problems)

Dutch eurots@powerquest.com

English support@powerquest.com*
eurots@powerquest.com

French france@powerquest.com

German germany@powerquest.com

Italian italian@powerquest.com

Portuguese latina@powerquest.com

Spanish spanish@powerquest.com

Location Number

U.S.A. (801) 437-4218

Europe +31 (0) 20 581 9270

http://www.powerquest.com/support/emsupport.html
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Telephone

The U.S.A. call center is open Monday through Friday from 7:00 a.m. to 6:00 p.m., 
MST/MDT. Our European call center, located in the Netherlands, is open Monday through 
Friday from 9:00 to 18:00, CET.

Postal Service Mail

Include a detailed description of your problem and a return address, a daytime phone 
number, or other relevant contact information.

Language Location Number

Dutch Netherlands +31 (0)20 581 3906

English Netherlands +31 (0)20 581 3907

English UK +44 (0)207 341 5517

English U.S.A. (888) 438-1260

French France +33 (0)169 324 930

German Germany +49 (0)696 656 8516

Italian Italy +39 (0)24 528 1312

Spanish Spain +34 (0)916 623 1 46

Spanish U.S.A. (801) 226-6834

U.S.A. Europe

PowerQuest Corporation
P.O. Box 1911
Orem, Utah 84059-1911
U.S.A.

PowerQuest Customer Service
P.O. Box 58287
1040 HG
Amsterdam, Netherlands
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changing  68
changing under Windows NT  98
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See rescue disks
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extended-x file system  64
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partitions, information about  92
partitions, resizing  75

FAT information  93

FAT16x  64
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pending changes  62

pending operations, viewing  62

physical disk, selecting  59

physical geometry  93

ping frequency, setting  38

PowerQuest web site  172

PQ_DEBUG.TXT file  152

preferences  66
allow 64K FAT clusters for Windows NT  66
ignore OS/2 EA errors on FAT  67
set as read-only for VolumeManager  67
skip nad sector checks  67
system supports FAT32  66
wizard buttons, hiding  132

preparing for a new operating system
See creating new partitions

preparing to run VolumeManager  50

primary partitions, converting to logical  127

process overview  59

R
README file  69

read-only, set hard disk as  67

reclaiming wasted space  102

redistribute free space wizard  131

reducing the number of partitions  88

Remote Agent  133
boot disks, creating under Windows  135
boot disks, using  139
errors  160
overview  134
running without a boot disk  139

remote servers
accessing  140
See also Remote Agent

removable media, using VolumeManager with  60

reports, ControlCenter ST for StorageMonitor  29

rescue disks
contents of  17
creating  16
feature differences from Windows version  55
international keyboards and  68
ran out of space on  18
running PARTINFO from  153
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running VolumeManager from  55

resizing
clusters manually  102
operation  72
partition won’t reboot after resizing  151
partitions, limitations  75
root directory  100
volume sets  107

restoring deleted partitions  81

retesting bad sectors  98

reusing old server disk  143

root directory
FAT, capacity in  94
index, error in  168
long filenames in  100
resizing  100

running VolumeManager  51
from rescue disks  55

running wizards  130

S
scanning for errors  96

scripting  132
running from rescue disks  57
See also online help

SCSI hard disk, using VolumeManager on  150

sectors, bad  156,  164

sectors, retesting bad  98

selecting
disks  59
operations  61
partitions  60

selecting volume sets  60

server alerts configuration  31

server disk
installing new  142
reusing old  143

server information, displaying  31

server, control  21

server, IIS  22

servers
adding to user-defined groups  27
removing from user-defined groups  27
viewing information in console  31
viewing on console  30
viewing within directory groups  30

set active  101

set hard disks as read-only for VolumeManager  67

shredding partitions  80

skipping bad sector checks  67

software requirements, ControlCenter ST for 
StorageMonitor  7

software requirements, VolumeManager  6
splitting partitions  89

startup switches  132

status bar  57

StorageMonitor
See ControlCenter ST for StorageMonitor

support, technical  172

system requirements, ControlCenter ST for 
StorageMonitor  7

system requirements, VolumeManager  6
system supports FAT32  66

T
technical support  172

fax  173
mail  174
postal service mail  174
telephone  174
web site  172

threshold levels, setting for ControlCenter ST for 
StorageMonitor  36

thresholds
modifying for individual servers  32

total physical sectors  93

transport settings, ControlCenter ST Agent  43

troubleshooting  149
changes entered seem to have disappeared  130
CIM Agents and VolumeManager  148
drive letter assignments changed  85
I can’t boot my server  16
I forgot the password for VolumeManager  165
I hid partition where VolumeManager is 

installed  55
logging onto StorageMonitor  23
my server won’t boot  68
NTFS features lost when converting to FAT or 

FAT32  125
partition unbootable after resizing  151
running VolumeManager on a machine with a 

boot partition on a dynamic disk  51
services aren’t starting now that I copied my NT 

boot partition  85
tips  172
workstation is unbootable  74
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U
unallocated space  66

redistributing  131
required to move a partition  73

undeleting partitions  81

undo  61

unformatted partitions  66

unhiding partitions  99

uninstalling VolumeManager  18

unused space  92

unused space, redistributing  131

user-defined group of servers
deleting server from  28
renaming  27

user-defined group of servers, creating  26

user-defined groups of servers  30

users
adding for ControlCenter ST  39
removing access to ControlCenter ST for  40

utilities, operating system  150
CheckDisk  96
CHKDSK  86,  95
FDISK  159
NT CheckDisk  96

V
viewing all servers  30

virus protection software  148

virus protection software, compatibility with 
VolumeManager  148

viruses, removing  151

volume information, displaying  31

volume set segments, moving  115

volume sets
checking integrity of  113
copying  106
deleting  113
displaying information about  31,  109
formatting  108
labeling  109
moving segments  115
resizing  107
scanning for errors  96
selecting  60
viewing all (console)  33

VolumeManager
compatibility with virus protection 

software  148
PartitionInfo program  152
preferences, setting  66
preparing to run  50
running  51

volumes
See volume sets

W
warnings  125

wasted space, reclaiming  102

web server  22

web-based console  21

Windows 2000
dynamic disks  60
volume sets, selecting  60

Windows NT
64K FAT clusters  66
changing drive letters  98
CheckDisk  96
error messages, involving  166

wizards
applying or discarding changes  130
copying partitions  131
create new partition  130
hiding buttons on main screen  132
merging partitions  131
overview  53,  130
redistributing free space  131
running  130

Z
Zip disks, using VolumeManager with  60
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